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Product notice
This guide describes features that are
common to most models. Some features may
not be available on your computer.
Not all features are available on all editions
of Windows 8. This computer may require
upgraded and/or separately purchased
hardware, drivers, and/or software to take
full advantage of Windows 8 functionality.
See http://www.microsoft.com for details.
This computer may require upgraded and/
or separately purchased hardware and/or a
DVD drive to install the Windows 7 software
and take full advantage of Windows 7
functionality. See
http://windows.microsoft.com/en-us/
windows7/get-know-windows-7 for details.

Safety warning notice
WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the
skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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Product features

Standard configuration features
Features may vary depending on the model. For a complete listing of the hardware and software
installed in the computer, run the diagnostic utility (included on some computer models only).
NOTE: This computer model can be used in a tower orientation or a desktop orientation. The tower
stand is sold separately.

Standard configuration features
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Front panel components
Drive configuration may vary by model. Some models have a bezel blank covering one or more drive
bays.

1

Dual-State Power Button

4

USB 3.0 Port - Charging

2

Hard Drive Activity Light

5

Microphone/Headphone Connector

3

USB 3.0 Port

6

Headphone Connector

NOTE: The USB 3.0 Port - Charging also provides current to charge a device such as a Smart Phone. The
charging current is available whenever the power cord is plugged into the system, even when the system is off.
NOTE: When a device is plugged into the Microphone/Headphone Connector, a dialog box will pop up asking if
you want to use the connector for a microphone Line-In device or a headphone. You can reconfigure the connector
at any time by double-clicking the Audio Manager icon in the Windows taskbar.
NOTE: The Power On Light is normally white when the power is on. If it is flashing red, there is a problem with the
computer and it is displaying a diagnostic code. Refer to theInterpreting POST diagnostic front panel LEDs
on page 140 to interpret the code.
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Rear panel components (EliteDesk 800)

1

DisplayPort Monitor Connectors

4

USB 3.0 Ports (blue)

2

VGA Monitor Connector

5

RJ-45 Network Connector

3

Line-Out Connector for powered audio devices
(green)

6

Power Cord Connector

Rear panel components (EliteDesk 800)
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Rear panel components (ProDesk 600)

4

1

DisplayPort Monitor Connectors

5

USB 3.0 Ports (blue)

2

VGA Monitor Connector

6

RJ-45 Network Connector

3

Line-Out Connector for powered audio devices
(green)

7

Power Cord Connector

4

USB 2.0 Ports (black)
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Serial number location
Each computer has a unique serial number and a product ID number that are located on the exterior of
the computer. Keep these numbers available for use when contacting customer service for assistance.

Serial number location
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Activating and Customizing the
Software

NOTE: This chapter provides information for both Windows 7 and Windows 8.

Activating and customizing the software in
Windows 7
If your computer was not shipped with a Windows® operating system, some portions of this
documentation do not apply. Additional information is available in online help after you activate the
operating system.
CAUTION: Do not add optional hardware or third-party devices to the computer until the operating
system is successfully activated. Doing so may cause errors and prevent the operating system from
installing properly.
NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor to
permit the required airflow.

Activating the Windows operating system
The first time you turn on the computer, the operating system is set up and activated automatically. This
process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to
complete the activation.
We recommend that you register your computer with HP during operating system setup so you can
receive important software updates, facilitate support questions, and sign up for special offers.
CAUTION: After the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL THE
PROCESS IS COMPLETE. Turning off the computer during the activation process may damage the
software that runs the computer or prevent its proper installation.
NOTE: If the computer shipped with more than one operating system language on the hard drive, the
activation process could take up to 60 minutes.
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Downloading Windows 7 updates
Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.
1.

To set up your Internet connection, click Start > Internet Explorer and follow the instructions
on the screen.

2.

After an Internet connection has been established, click the Start > All Programs > Windows
Update.

3.

Run Windows Update monthly thereafter.

Installing or upgrading device drivers
When installing optional hardware devices after the operating system installation is complete, you must
also install the drivers for each of the devices.
In Windows 7, if prompted for the i386 directory, replace the path specification with C:\i386, or use
the Browse button in the dialog box to locate the i386 folder. This action points the operating system
to the appropriate drivers.
Obtain the latest support software, including support software for the operating system, from
http://www.hp.com/support. Select your country and language, select Download drivers and
software (and firmware), enter the model number of the computer, and press Enter.

Customizing the monitor display
If you wish, you can select or change the monitor refresh rates, screen resolution, color settings, font
sizes, and power management settings.
For more information, refer to the online documentation provided with the graphics controller utility or
the documentation that came with your monitor.
Right-click on the Windows desktop, then click Personalize to change display settings.

Activating and customizing the software in
Windows 8
Additional information is available in online help after you activate the operating system.
NOTE: Be sure there is a 10.2 cm (4 inch) clearance at the back of the unit and above the monitor to
permit the required airflow.

Activating the Windows Operating System
The first time you turn on the computer, the operating system is set up and activated automatically. This
process takes about 5 to 10 minutes. Carefully read and follow the instructions on the screen to
complete the activation.

Activating and customizing the software in Windows 8
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We recommend that you register your computer with HP during operating system set up so you can
receive important software updates, facilitate support questions, and sign up for special offers. You can
also register your computer with HP using the Register with HP app on the Start screen.
CAUTION: After the activation process has begun, DO NOT TURN OFF THE COMPUTER UNTIL THE
PROCESS IS COMPLETE. Turning off the computer during the activation process may damage the
software that runs the computer or prevent its proper installation.

Downloading Windows 8 updates
Microsoft may release updates to the operating system. To help keep the computer running optimally,
HP recommends checking for the latest updates during the initial installation and periodically
throughout the life of the computer.
Run Windows Update as soon as possible after you set up your computer.
1.

Point to the upper-right or lower-right corner of the Start screen to display the charms.

2.

Click Settings > Change PC Settings > Windows Update.

3.

Run Windows Update monthly thereafter.

Customizing the monitor display
You can customize display settings for Windows 8 separately for the Start screen and the Desktop.
To customize the Start screen:
1.

Point to the upper-right or lower-right corner of the Start screen to display the charms.

2.

Click Settings > Change PC Settings.

3.

Click Personalize to change the display settings.

To customize the Desktop:
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1.

Click the Desktop app on the Start screen.

2.

Right-click on the desktop, and then click Personalize to change display settings.
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3

Routine care, SATA drive
guidelines, and disassembly
preparation

This chapter provides general service information for the computer. Adherence to the procedures and
precautions described in this chapter is essential for proper service.
CAUTION: When the computer is plugged into an AC power source, voltage is always applied to
the system board. You must disconnect the power cord from the power source before opening the
computer to prevent system board or component damage.

Electrostatic discharge information
A sudden discharge of static electricity from your finger or other conductor can destroy static-sensitive
devices or microcircuitry. Often the spark is neither felt nor heard, but damage occurs. An electronic
device exposed to electrostatic discharge (ESD) may not appear to be affected at all and can work
perfectly throughout a normal cycle. The device may function normally for a while, but it has been
degraded in the internal layers, reducing its life expectancy.
Networks built into many integrated circuits provide some protection, but in many cases, the discharge
contains enough power to alter device parameters or melt silicon junctions.

Electrostatic discharge information
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Generating static
The following table shows that:
●

Different activities generate different amounts of static electricity.

●

Static electricity increases as humidity decreases.
Relative Humidity

Event

55%

40%

10%

Walking across carpet

7,500 V

15,000 V

35,000 V

Walking across vinyl floor

3,000 V

5,000 V

12,000 V

Motions of bench worker

400 V

800 V

6,000 V

Removing DIPs from plastic tube

400 V

700 V

2,000 V

Removing DIPs from vinyl tray

2,000 V

4,000 V

11,500 V

Removing DIPs from Styrofoam

3,500 V

5,000 V

14,500 V

Removing bubble pack from PCB

7,000 V

20,000 V

26,500 V

Packing PCBs in foam-lined box

5,000 V

11,000 V

21,000 V

These are then multi-packaged inside plastic tubes, trays, or Styrofoam.

NOTE: 700 volts can degrade a product.

Preventing electrostatic damage to equipment
Many electronic components are sensitive to ESD. Circuitry design and structure determine the degree
of sensitivity. The following packaging and grounding precautions are necessary to prevent damage to
electric components and accessories.
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●

To avoid hand contact, transport products in static-safe containers such as tubes, bags, or boxes.

●

Protect all electrostatic parts and assemblies with conductive or approved containers or
packaging.

●

Keep electrostatic sensitive parts in their containers until they arrive at static-free stations.

●

Place items on a grounded surface before removing them from their container.

●

Always be properly grounded when touching a sensitive component or assembly.

●

Avoid contact with pins, leads, or circuitry.

●

Place reusable electrostatic-sensitive parts from assemblies in protective packaging or conductive
foam.

Chapter 3 Routine care, SATA drive guidelines, and disassembly preparation

Personal grounding methods and equipment
Use the following equipment to prevent static electricity damage to equipment:
●

Wrist straps are flexible straps with a maximum of one-megohm ± 10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against bare skin. The ground cord
must be connected and fit snugly into the banana plug connector on the grounding mat or
workstation.

●

Heel straps/Toe straps/Boot straps can be used at standing workstations and are
compatible with most types of shoes or boots. On conductive floors or dissipative floor mats, use
them on both feet with a maximum of one-megohm ± 10% resistance between the operator and
ground.
Static Shielding Protection Levels
Method

Voltage

Antistatic plastic

1,500

Carbon-loaded plastic

7,500

Metallized laminate

15,000

Grounding the work area
To prevent static damage at the work area, use the following precautions:
●

Cover the work surface with approved static-dissipative material. Provide a wrist strap connected
to the work surface and properly grounded tools and equipment.

●

Use static-dissipative mats, foot straps, or air ionizers to give added protection.

●

Handle electrostatic sensitive components, parts, and assemblies by the case or PCB laminate.
Handle them only at static-free work areas.

●

Turn off power and input signals before inserting and removing connectors or test equipment.

●

Use fixtures made of static-safe materials when fixtures must directly contact dissipative surfaces.

●

Keep work area free of nonconductive materials such as ordinary plastic assembly aids and
Styrofoam.

●

Use field service tools, such as cutters, screwdrivers, and vacuums, that are conductive.

Recommended materials and equipment
Materials and equipment that are recommended for use in preventing static electricity include:
●

Antistatic tape

●

Antistatic smocks, aprons, or sleeve protectors

●

Conductive bins and other assembly or soldering aids

Electrostatic discharge information
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●

Conductive foam

●

Conductive tabletop workstations with ground cord of one-megohm +/- 10% resistance

●

Static-dissipative table or floor mats with hard tie to ground

●

Field service kits

●

Static awareness labels

●

Wrist straps and footwear straps providing one-megohm +/- 10% resistance

●

Material handling packages

●

Conductive plastic bags

●

Conductive plastic tubes

●

Conductive tote boxes

●

Opaque shielding bags

●

Transparent metallized shielding bags

●

Transparent shielding tubes

Operating guidelines
To prevent overheating and to help prolong the life of the computer:
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●

Keep the computer away from excessive moisture, direct sunlight, and extremes of heat and cold.

●

Operate the computer on a sturdy, level surface. Leave a 10.2-cm (4-inch) clearance on all vented
sides of the computer and above the monitor to permit the required airflow.

●

Never restrict the airflow into the computer by blocking any vents or air intakes. Do not place the
keyboard, with the keyboard feet down, directly against the front of the desktop unit as this also
restricts airflow.

●

Occasionally clean the air vents on all vented sides of the computer. Lint, dust, and other foreign
matter can block the vents and limit the airflow. Be sure to unplug the computer before cleaning
the air vents.

●

Never operate the computer with the cover or side panel removed.

●

Do not stack computers on top of each other or place computers so near each other that they are
subject to each other’s re-circulated or preheated air.

●

If the computer is to be operated within a separate enclosure, intake and exhaust ventilation must
be provided on the enclosure, and the same operating guidelines listed above will still apply.

●

Keep liquids away from the computer and keyboard.
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●

Never cover the ventilation slots on the monitor with any type of material.

●

Install or enable power management functions of the operating system or other software, including
sleep states.

Routine care
General cleaning safety precautions
1.

Never use solvents or flammable solutions to clean the computer.

2.

Never immerse any parts in water or cleaning solutions; apply any liquids to a clean cloth and
then use the cloth on the component.

3.

Always unplug the computer when cleaning with liquids or damp cloths.

4.

Always unplug the computer before cleaning the keyboard, mouse, or air vents.

5.

Disconnect the keyboard before cleaning it.

6.

Wear safety glasses equipped with side shields when cleaning the keyboard.

Cleaning the Computer Case
Follow all safety precautions in General cleaning safety precautions on page 13 before cleaning the
computer.
To clean the computer case, follow the procedures described below:
●

To remove light stains or dirt, use plain water with a clean, lint-free cloth or swab.

●

For stronger stains, use a mild dishwashing liquid diluted with water. Rinse well by wiping it with
a cloth or swab dampened with clear water.

●

For stubborn stains, use isopropyl (rubbing) alcohol. No rinsing is needed as the alcohol will
evaporate quickly and not leave a residue.

●

After cleaning, always wipe the unit with a clean, lint-free cloth.

●

Occasionally clean the air vents on the computer. Lint and other foreign matter can block the vents
and limit the airflow.

Cleaning the keyboard
Follow all safety precautions in General cleaning safety precautions on page 13 before cleaning the
keyboard.
To clean the tops of the keys or the keyboard body, follow the procedures described in Cleaning the
Computer Case on page 13.
When cleaning debris from under the keys, review all rules in General cleaning safety precautions
on page 13 before following these procedures:

Routine care
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CAUTION: Use safety glasses equipped with side shields before attempting to clean debris from
under the keys.
●

Visible debris underneath or between the keys may be removed by vacuuming or shaking.

●

Canned, pressurized air may be used to clean debris from under the keys. Caution should be used
as too much air pressure can dislodge lubricants applied under the wide keys.

●

If you remove a key, use a specially designed key puller to prevent damage to the keys. This tool
is available through many electronic supply outlets.
CAUTION: Never remove a wide leveled key (like the space bar) from the keyboard. If these
keys are improperly removed or installed, the keyboard may not function properly.

●

Cleaning under a key may be done with a swab moistened with isopropyl alcohol and squeezed
out. Be careful not to wipe away lubricants necessary for proper key functions. Use tweezers to
remove any fibers or dirt in confined areas. Allow the parts to air dry before reassembly.

Cleaning the monitor
●

Wipe the monitor screen with a clean cloth moistened with water or with a towelette designed for
cleaning monitors. Do not use sprays or aerosols directly on the screen; the liquid may seep into
the housing and damage a component. Never use solvents or flammable liquids on the monitor.

●

To clean the monitor body follow the procedures in Cleaning the Computer Case on page 13.

Cleaning the mouse
Before cleaning the mouse, ensure that the power to the computer is turned off.
●

Clean the mouse ball by first removing the retaining plate and the ball from the housing. Pull out
any debris from the ball socket and wipe the ball with a clean, dry cloth before reassembly.

●

To clean the mouse body, follow the procedures in Cleaning the Computer Case on page 13.

Service considerations
Listed below are some of the considerations that you should keep in mind during the disassembly and
assembly of the computer.

Tools and software Requirements
To service the computer, you need the following:
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●

Torx T-15 screwdriver

●

Torx T-15 screwdriver with small diameter shank (for certain front bezel removal)

●

Flat-bladed screwdriver (may sometimes be used in place of the Torx screwdriver)

●

Phillips #2 screwdriver
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●

Diagnostics software

●

Tamper-resistant T-15 wrench

Screws
The screws used in the computer are not interchangeable. They may have standard or metric threads
and may be of different lengths. If an incorrect screw is used during the reassembly process, it can
damage the unit. HP strongly recommends that all screws removed during disassembly be kept with the
part that was removed, then returned to their proper locations.
CAUTION: Metric screws have a black finish. U.S. screws have a silver finish and are used on hard
drives only.
CAUTION: As each subassembly is removed from the computer, it should be placed away from the
work area to prevent damage.

Cables and connectors
Most cables used throughout the unit are flat, flexible cables. These cables must be handled with care
to avoid damage. Apply only the tension required to seat or unseat the cables during insertion or
removal from the connector. Handle cables by the connector whenever possible. In all cases, avoid
bending or twisting the cables, and ensure that the cables are routed in such a way that they cannot be
caught or snagged by parts being removed or replaced.
CAUTION: When servicing this computer, ensure that cables are placed in their proper location
during the reassembly process. Improper cable placement can damage the computer.

Hard Drives
Handle hard drives as delicate, precision components, avoiding all physical shock and vibration. This
applies to failed drives as well as replacement spares.
●

If a drive must be mailed, place the drive in a bubble-pack mailer or other suitable protective
packaging and label the package “Fragile: Handle With Care.”

●

Do not remove hard drives from the shipping package for storage. Keep hard drives in their
protective packaging until they are actually mounted in the CPU.

●

Avoid dropping drives from any height onto any surface.

●

If you are inserting or removing a hard drive, turn off the computer. Do not remove a hard drive
while the computer is on or in standby mode.

●

Before handling a drive, ensure that you are discharged of static electricity. While handling a
drive, avoid touching the connector. For more information about preventing electrostatic damage,
refer to Electrostatic discharge information on page 9

●

Do not use excessive force when inserting a drive.

●

Avoid exposing a hard drive to liquids, temperature extremes, or products that have magnetic
fields such as monitors or speakers.

Service considerations
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Lithium coin cell battery
The battery that comes with the computer provides power to the real-time clock and has a minimum
lifetime of about three years.
See the appropriate removal and replacement chapter for the chassis you are working on in this guide
for instructions on the replacement procedures.
WARNING! This computer contains a lithium battery. There is a risk of fire and chemical burn if the
battery is handled improperly. Do not disassemble, crush, puncture, short external contacts, dispose in
water or fire, or expose it to temperatures higher than 140ºF (60ºC). Do not attempt to recharge the
battery.
NOTE: Batteries, battery packs, and accumulators should not be disposed of together with the
general household waste. In order to forward them to recycling or proper disposal, please use the
public collection system or return them to HP, their authorized partners, or their agents.

SATA hard drives
Serial ATA Hard Drive Characteristics
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Number of pins/conductors in data cable

7/7

Number of pins in power cable

15

Maximum data cable length

39.37 in (100 cm)

Data interface voltage differential

400-700 mV

Drive voltages

3.3 V, 5 V, 12 V

Jumpers for configuring drive

N/A

Data transfer rate

3.0 Gb/s
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SATA hard drive cables
SATA data cable
Always use an HP approved SATA 3.0 Gb/s cable as it is fully backwards compatible with the SATA
1.5 Gb/s drives.
Current HP desktop products ship with SATA 3.0 Gb/s hard drives.
SATA data cables are susceptible to damage if overflexed. Never crease a SATA data cable and never
bend it tighter than a 30 mm (1.18 in) radius.
The SATA data cable is a thin, 7-pin cable designed to transmit data for only a single drive.

SMART ATA drives
The Self Monitoring Analysis and Recording Technology (SMART) ATA drives for the HP Personal
Computers have built-in drive failure prediction that warns the user or network administrator of an
impending failure or crash of the hard drive. The SMART drive tracks fault prediction and failure
indication parameters such as reallocated sector count, spin retry count, and calibration retry count. If
the drive determines that a failure is imminent, it generates a fault alert.

Cable management
Always follow good cable management practices when working inside the computer.
●

Keep cables away from major heat sources like the heat sink.

●

Do not jam cables on top of expansion cards or memory modules. Printed circuit cards like these
are not designed to take excessive pressure on them.

●

Keep cables clear of sliding or moveable parts to prevent them from being cut or crimped when
the parts are moved.

●

When folding a flat ribbon cable, never fold to a sharp crease. Sharp creases may damage the
wires.

●

Some flat ribbon cables come prefolded. Never change the folds on these cables.

●

Do not bend any cable sharply. A sharp bend can break the internal wires.

●

Never bend a SATA data cable tighter than a 30 mm (1.18 in) radius.

●

Never crease a SATA data cable.

●

Do not rely on components like the drive cage, power supply, or computer cover to push cables
down into the chassis. Always position the cables to lay properly by themselves.

SATA hard drive cables
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Illustrated parts catalog

NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and
then follow the on-screen instructions.
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Item

Description

Spare part number

(1)

Access panel

768428-001

(2)

Front bezel
For use in EliteDesk 800 models

768422-001

For use in ProDesk 600 models

768742-001
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Item

(3)

Description

Spare part number

Stand

768430-001

Power supply, 65W

751889-001

System board (includes replacement thermal material)
For use in EliteDesk 800 models:
●

For use in models without the-Windows 8 operating system

746632-001

●

For use in models with Windows 8 Standard

746632-501

●

For use in models with Windows 8 Professional

746632-601

For use in ProDesk 800 models:
●

For use in models without the-Windows 8 operating system

746722-001

●

For use in models with Windows 8 Standard

746722-501

●

For use in models with Windows 8 Professional

746722-601

●

For use in models with NetClone operating system

765381-001

Memory module, PC3-12800, 1666-MHz
4 GB

689373-001

8 GB

689374-001

Processors (include replacement thermal material)
Intel Core i7 4785T processor, 2.2 GHz, 8-MB L3 cache, 35W

773230-001

Intel Core i7 4765T processor, 2.0 GHz, 8-MB L3 cache, 35W

754000-001

Intel Core i5 4590T processor, 2.0 GHz, 6-MB L3 cache, 35W

773228-001

Intel Core i5 4570T processor, 2.9 GHz, 4-MB L3 cache, 35W

753998-001

Intel Core i3 4330T processor, 3.0 GHz, 4-MB L3 cache, 35W

753995-001

Intel Core i3 4150T processor, 3.0 GHz, 3-MB L3 cache, 35W (ProDesk 600 models
only)

773226-001

Intel Core i3 4130T processor, 2.9 GHz, 3-MB L3 cache, 35W

757416-001

Intel Pentium G3440T processor, 2.8 GHz, 3-MB L3 cache, 35W

773233-001

Intel Pentium G3420T processor, 2.7 GHz, 3-MB L3 cache, 35W

763217-001

Intel Pentium G3240T processor, 2.7 GHz, 3-MB L3 cache, 35W

773232-001

Intel Pentium G3220T processor, 2.6 GHz, 3-MB L3 cache, 35W

763216-001

Intel Celeron G1840T processor, 2.5 GHz, 2-MB L3 cache, 35W

773225-001

Intel Celeron G1820T processor, 2.4 GHz, 2-MB L3 cache, 35W

753994-001

Keyboards
USB, Smartcard, CCID

701671-xx1

USB

724720-xx1
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Item

Description

Spare part number

PS2, washable

700510-xx1

Wireless keyboard and dongle for use in Brazil

724722-201

Wireless keyboard, mouse, and dongle

730323-xx1

Misc parts
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Description

Spare part number

(1)

Heat sink

768426-001

(2)

Fan

768424-001

(3)

Speaker

762420-001

(4)

LED cover

768425-001

Hood sensor assembly

768429-001

Antenna cover

768433-001

Grommet for use mounting hard drives

594220-001

HP Ultraslim Keyed Cable Lock

703372-001
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Description

Spare part number

WLAN modules:
HP WLAN 802.11 a/b/g/n, 2x2

768423-001

HP WLAN 802.11 a/g/n, for use only in Indonesia

750552-001

Mouse
USB, optical

674316-001

Wireless

674317-001

USB, laser

674318-001

Washable

724795-001

Description

Spare part number

SATA power cable

768427-001

Wireless antenna cables

768432-001

Adapter, DisplayPort to VGA

632484-001

Adapter, DisplayPort to DVI

662723-001

Adapter, DisplayPort to HDMI

617450-001

DisplayPort cable

487562-001

USB to serial converter

407185-001

Cables

(1)

Cables
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Drives
Description

Spare part number

Hard drives/solid-state/M.2 drives:
1 TB, 7200 rpm, hard drive, 2.5-inch, SSHD

724937-001

500 GB, 7200 rpm hard drive, 2.5-inch

745135-001

500 GB, 7200 rpm, hard drive, 2.5-inch, SSHD

724938-001

500 GB, 7200 rpm hard drive, 2.5-inch, SED

745136-001

256 GB solid-state drive (SSD), self-encrypting (SED)

746141-001

180 GB solid-state drive (SSD), SATA 6.0, MLC

754076-001

128 GB solid-state drive (SSD), M.2

757990-001

128 GB solid-state drive (SSD)

665961-001

128 GB solid-state drive (SSD), Self-encrypting Drive (SED), SATA 6.0

746140-001

120 GB solid-state drive (SSD), SATA 6.0, MLC

756459-001

Sequential Part Number Listing
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Spare part
number

Description

407185-001

USB to serial converter

487562-001

DisplayPort cable

594220-001

Grommet for use mounting hard drives

617450-001

Display Port (DP) to HDMI

632484-001

Display Port (DP) to VGA

662723-001

Display Port (DP) to DVI

665961-001

128 GB solid-state drive (SSD)

674316-001

Mouse, USB, optical

674317-001

Mouse, wireless

674318-001

Mouse, USB, laser

689373-001

4-GB memory module, PC3-12800, 1666-MHz

689374-001

8-GB memory module, PC3-12800, 1666-MHz

700510-xx1

Keyboard, PS2, washable

701671-xx1

Keyboard, USB, Smartcard, CCID

703372-001

HP Ultraslim Keyed Cable Lock
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Spare part
number

Description

724720-xx1

Keyboard, USB

724722-201

Keyboard, wireless keyboard and dongle for use in Brazil

724795-001

Mouse, washable

724937-001

1 TB, 7200 rpm, hard drive, 2.5-inch, SSHD

724938-001

500 GB, 7200 rpm, hard drive, 2.5-inch, SSHD

730323-xx1

Keyboard, wireless keyboard, mouse, and dongle

745135-001

500 GB, 7200 rpm hard drive, 2.5-inch

745136-001

500 GB, 7200 rpm hard drive, 2.5-inch, SED

746140-001

128 GB solid-state drive (SSD), Self-encrypting Drive (SED), SATA 6.0

746141-001

256 GB solid-state drive (SSD), self-encrypting (SED)

746632-001

System board for use in EliteDesk 800 models without the Windows 8 operating system (includes replacement
thermal material)

746632-501

System board for use in EliteDesk 800 models with Windows 8 Standard (includes replacement thermal
material)

746632-601

System board for use in EliteDesk 800 models with Windows 8 Professional (includes thermal material)

746722-001

System board for use in ProDesk 600 models without the Windows 8 operating system

746722-501

System board for use in ProDesk 600 models with Windows 8 Standard

746722-601

System board for use in ProDesk 600 models with Windows 8 Professional

765381-001

System board for use in ProDesk 600 models with NetClone operating system

750552-001

HP WLAN 802.11 a/g/n, for use only in Indonesia

751889-001

Power supply, external, 65W

753994-001

Intel Celeron G1820T processor, 2.4 GHz, 2-MB L3 cache, 35W

753995-001

Intel Core i3 4330T processor, 3.0 GHz, 4-MB L3 cache, 35W

753998-001

Intel Core i5 4570T processor, 2.9 GHz, 4-MB L3 cache, 35W

754000-001

Intel Core i7 4765T processor, 2.0 GHz, 8-MB L3 cache, 35W

754076-001

180 GB solid-state drive (SSD), SATA 6.0, MLC

756459-001

120 GB solid-state drive (SSD), SATA 6.0, MLC

757416-001

Intel Core i3 4130T processor, 2.9 GHz, 3-MB L3 cache, 35W

757990-001

128 GB solid-state drive (SSD), M.2

762420-001

Speaker

763216-001

Intel Pentium G3220T processor, 2.6 GHz, 3-MB L3 cache, 35W

763217-001

Intel Pentium G3420T processor, 2.7 GHz, 3-MB L3 cache, 35W

768422-001

Front bezel for use on EliteDesk 800 models

Sequential Part Number Listing
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Spare part
number

Description

768423-001

HP WLAN 802.11 a/b/g/n, 2x2

768424-001

Fan

768425-001

LED cover

768426-001

Heat sink

768427-001

SATA power cable

768428-001

Access panel

768429-001

Hood sensor assembly

768430-001

Stand

768432-001

Wireless antenna cables

768433-001

Antenna cover

768742-001

Front bezel for use on ProDesk 600 models

773225-001

Intel Celeron G1840T processor, 2.5 GHz, 2-MB L3 cache, 35W

773226-001

Intel Core i3 4150T processor, 3.0 GHz, 3-MB L3 cache, 35W (ProDesk 600 models only)

773228-001

Intel Core i5 4590T processor, 2.0 GHz, 6-MB L3 cache, 35W

773230-001

Intel Core i7 4785T processor, 2.2 GHz, 8-MB L3 cache, 35W

773232-001

Intel Pentium G3240T processor, 2.7 GHz, 3-MB L3 cache, 35W

773233-001

Intel Pentium G3440T processor, 2.8 GHz, 3-MB L3 cache, 35W
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Removal and Replacement
Procedures

The following sections provide information about disassembling various components of the computer.
NOTE: HP continually improves and changes product parts. For complete and current information on
supported parts for your computer, go to http://partsurfer.hp.com, select your country or region, and
then follow the on-screen instructions.

Preparing to disassemble the computer
To avoid injury and equipment damage, always complete the following steps in order, when opening
the computer.
1.

Remove/disengage any security devices that prohibit opening the computer.

2.

Remove all removable media, such as a USB flash drive, from the computer.

3.

Turn off the computer properly through the operating system, then turn off any external devices.

4.

Disconnect the power cord from the power outlet and disconnect any external devices.
CAUTION: Regardless of the power-on state, voltage is always present on the system board as
long as the system is plugged into an active AC outlet. You must disconnect the power cord to
avoid damage to the internal components of the computer.

5.

If the computer is on a stand, remove the computer from the stand.

WARNING!

Beware of sharp edges inside the chassis.

Preparing to disassemble the computer
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Access panel
Description

Spare part number

Access panel

768428-001

To access internal components, you must remove the access panel:
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1.

Prepare the computer for disassembly (see Preparing to disassemble the computer on page 25).

2.

If the computer is on a stand, remove the computer from the stand and lay the computer down.

3.

Loosen the thumbscrew on the rear of the computer (1) then slide the panel forward and lift if off
the computer (2).
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Changing from desktop to tower configuration
The computer can be used in a tower orientation with an optional tower stand that can be purchased
from HP.
1.

Prepare the computer for disassembly (see Preparing to disassemble the computer on page 25).

2.

Orient the computer so that its right side is facing up and place the computer in the optional stand.

NOTE: To stabilize the computer in a tower orientation, HP recommends the use of the optional
tower stand.
3.

Reconnect the power cord and any external devices, then turn on the computer.
NOTE: Ensure at least 10.2 centimeters (4 inches) of space on all sides of the computer remains
clear and free of obstructions.

4.

Lock any security devices that were disengaged when the access panel was removed.

Changing from desktop to tower configuration
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Hard drive
Description

Spare part number

1 TB, 7200 rpm, hard drive, 2.5-inch, SSHD

724937-001

500 GB, 7200 rpm hard drive, 2.5-inch

745135-001

500 GB, 7200 rpm, hard drive, 2.5-inch, SSHD

724938-001

500 GB, 7200 rpm hard drive, 2.5-inch, SED

745136-001

256 GB solid-state drive (SSD), self-encrypting (SED)

746141-001

180 GB solid-state drive (SSD), SATA 6.0, MLC

754076-001

128 GB solid-state drive (SSD)

665961-001

128 GB solid-state drive (SSD), Self-encrypting Drive (SED), SATA 6.0

746140-001

120 GB solid-state drive (SSD), SATA 6.0, MLC

756459-001

NOTE: Before you remove the old hard drive, be sure to back up the data from the old hard drive so
that you can transfer the data to the new hard drive.
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1.

Prepare the computer for disassembly (see Preparing to disassemble the computer on page 25).

2.

Remove the access panel.

3.

Disconnect the hard drive power cable (1) and data cable (2) from the system board.
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4.

Pull the release lever next to the rear of the hard drive outward (1). While pulling the release lever
out, slide the drive back until it stops, then lift the drive up and out of the bay (2).

5.

To install a hard drive, you must transfer the silver and blue isolation mounting guide screws from
the old hard drive to the new hard drive.

Hard drive
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6.

Transfer the drive cables from the old drive to the new drive.

7.

Align the guide screws with the slots on the chassis drive cage, press the hard drive down into the
bay, then slide it forward until it stops and locks in place.
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8.

Connect the hard drive power cable (1) and data cable (2) to the system board.

Hard drive
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Speaker
Description

Spare part number

Speaker

762420-001

A single speaker is located on the left side of the computer behind the front bezel, inside the chassis. It
is secured by a white peg that you pull out to release.

To remove the speaker:
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1.

Prepare the computer for disassembly (see Preparing to disassemble the computer on page 25).

2.

Remove the access panel (see Access panel on page 26).

3.

From the front of the computer, pull to remove the white peg that secures the speaker (1).

4.

Disconnect the speaker cable from the system board connector (2).
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5.

Lift to remove the speaker from the computer (3).

To install the speaker, reverse the removal procedures.

Speaker

33

Front bezel
Description

Spare part number

Front bezel for use on EliteDesk 800 models

768422-001

Front bezel for use on ProDesk 600 models

768742-001

The front bezel is secured to the access panel by tabs.
To remove the front bezel:
1.

Prepare the computer for disassembly (see Preparing to disassemble the computer on page 25).

2.

Remove the access panel (see Access panel on page 26).

3.

Position the access panel upside-down so you can access the inside of the bezel.

4.

Pull down to loose the bottom, interior on the bezel (1).

5.

Disengage the tabs on the top, interior of the bezel (2).

6.

Remove the bezel from the access panel.

To install the front bezel, reverse the removal procedures.
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Memory
Description

Spare part number

Memory module, 4-GB

689373-001

Memory module, 8-GB

689374-001

The computer comes with double data rate 3 synchronous dynamic random access memory (DDR3SDRAM) small outline dual inline memory modules (SODIMMs).

SODIMMs
The memory sockets on the system board can be populated with up to two industry-standard
SODIMMs. These memory sockets are populated with at least one preinstalled SODIMM. To achieve
the maximum memory support, you can populate the system board with up to 16-GB of memory.

DDR3-SDRAM SODIMMs
For proper system operation, the SODIMMs must be:
●

industry-standard 204-pin

●

unbuffered non-ECC PC3-12800 DDR3-1600 MHz-compliant

●

1.35 volt or 1.5 volt DDR3-SDRAM SODIMMs

The DDR3-SDRAM SODIMMs must also:
●

support CAS latency 11 DDR3 1600 MHz (11-11-11 timing)

●

contain the mandatory Joint Electronic Device Engineering Council (JEDEC) specification

In addition, the computer supports:
●

512-Mbit, 1-Gbit, and 2-Gbit non-ECC memory technologies

●

single-sided and double-sided SODIMMS

●

SODIMMs constructed with x8 and x16 devices; SODIMMs constructed with x4 SDRAM are not
supported

NOTE: The system will not operate properly if you install unsupported SODIMMs.

Memory
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Populating SODIMM sockets
There are two SODIMM sockets on the system board, with one socket per channel. The sockets are
labeled DIMM1 and DIMM3. The DIMM1 socket operates in memory channel B. The DIMM3 socket
operates in memory channel A.

Item

Description

System Board Label

Socket Color

1

SODIMM1 socket, Channel B

DIMM1

Black

2

SODIMM3 socket, Channel A

DIMM3

Black

The system will automatically operate in single channel mode, dual channel mode, or flex mode,
depending on how the SODIMMs are installed.
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●

The system will operate in single channel mode if the SODIMM sockets are populated in one
channel only.

●

The system will operate in a higher-performing dual channel mode if the memory capacity of the
SODIMM in Channel A is equal to the memory capacity of the SODIMM in Channel B.

●

The system will operate in flex mode if the memory capacity of the SODIMM in Channel A is not
equal to the memory capacity of the SODIMM in Channel B. In flex mode, the channel populated
with the least amount of memory describes the total amount of memory assigned to dual channel
and the remainder is assigned to single channel. If one channel will have more memory than the
other, the larger amount should be assigned to channel A.

●

In any mode, the maximum operational speed is determined by the slowest SODIMM in the
system.
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Installing SODIMMs
CAUTION: You must disconnect the power cord and wait approximately 30 seconds for the power
to drain before adding or removing memory modules. Regardless of the power-on state, voltage is
always supplied to the memory modules as long as the computer is plugged into an active AC outlet.
Adding or removing memory modules while voltage is present may cause irreparable damage to the
memory modules or system board.
The memory module sockets have gold-plated metal contacts. When upgrading the memory, it is
important to use memory modules with gold-plated metal contacts to prevent corrosion and/or
oxidation resulting from having incompatible metals in contact with each other.
Static electricity can damage the electronic components of the computer or optional cards. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object. For more information, refer to Electrostatic discharge information on page 9.
When handling a memory module, be careful not to touch any of the contacts. Doing so may damage
the module.
1.

Prepare the computer for disassembly (see Preparing to disassemble the computer on page 25).

2.

Remove the access panel (see Access panel on page 26).

3.

Disconnect the hard drive power cable (1) and data cable (2) from the system board.
WARNING! To reduce risk of personal injury from hot surfaces, allow the internal system
components to cool before touching.

Memory
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4.

Pull the release lever next to the rear of the hard drive outward (1). While pulling the release lever
out, slide the drive back until it stops, then lift the drive up and out of the bay (2).

5.

To remove a SODIMM, press outward on the two latches on each side of the SODIMM (1) then
pull the SODIMM out of the socket (2).
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6.

Slide the new SODIMM into the socket at approximately a 30° angle (1) then press the SODIMM
down (2) so that the latches lock it in place.

NOTE: A memory module can be installed in only one way. Match the notch on the module with
the tab on the memory socket.
7.

Replace the hard drive and connect the power and data cables to the system board.

8.

Replace the access panel.

9.

If the computer was on a stand, replace the stand.

10. Reconnect the power cord and turn on the computer.
11. Lock any security devices that were disengaged when the computer cover or access panel was
removed.
The computer automatically recognizes the additional memory when you turn on the computer.

Memory
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Replacing the battery
The battery that comes with the computer provides power to the real-time clock. When replacing the
battery, use a battery equivalent to the battery originally installed in the computer. The computer comes
with a 3-volt lithium coin cell battery.
WARNING! The computer contains an internal lithium manganese dioxide battery. There is a risk of
fire and burns if the battery is not handled properly. To reduce the risk of personal injury:
Do not attempt to recharge the battery.
Do not expose to temperatures higher than 60°C (140ºF).
Do not disassemble, crush, puncture, short external contacts, or dispose of in fire or water.
Replace the battery only with the HP spare designated for this product.
CAUTION: Before replacing the battery, it is important to back up the computer CMOS settings.
When the battery is removed or replaced, the CMOS settings will be cleared.
Static electricity can damage the electronic components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of static electricity by briefly touching a
grounded metal object.
NOTE: The lifetime of the lithium battery can be extended by plugging the computer into a live AC
wall socket. The lithium battery is only used when the computer is NOT connected to AC power.
HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, go to http://www.hp.com/
recycle.

40

1.

Prepare the computer for disassembly (see Preparing to disassemble the computer on page 25).

2.

Remove the access panel.

3.

Locate the battery and battery holder on the system board.
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4.

Depending on the type of battery holder on the system board, complete the following instructions
to replace the battery.
NOTE: You may need to use a small tool, such as tweezers or needle-nose pliers, to remove and
replace the battery.
Type 1
a.

Pull back on the clip (1) that is holding the battery in place, and lift the battery out of the
holder (2).

b.

Pull back on the clip (1) and slide the replacement battery down into the holder (2).

Replacing the battery
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Type 2
a.

Push the battery toward the outside of the chassis to release it from the holder and lift it out.

b.

Lower the battery so that is next to the holder then push it into the holder.

NOTE: After the battery has been replaced, use the following steps to complete this procedure.
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5.

Replace the computer access panel.

6.

Plug in the computer and turn on power to the computer.

7.

Reset the date and time, your passwords, and any special system setups using Computer Setup.

8.

Lock any security devices that were disengaged when the computer access panel was removed.
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Heat sink
Description

Spare part number

Heat sink

768426-001

The heat sink is secured with four captive Torx screws. Be sure to remove and replace the screws in the
order indicated on the heat sink.
To remove the heat sink:
1.

Prepare the computer for disassembly (see Preparing to disassemble the computer on page 25).

2.

Remove the access panel (see Access panel on page 26).

3.

In the order indicated on the heat sink, loosen the four captive Torx screws (1), and then lift the
heat sink out of the computer (2).
CAUTION:
heat sink.

Be sure the loosen the screws in the order indicated by the numbers stamped on the

CAUTION: To reduce a degradation in thermal performance, be sure not to touch the thermal
grease on the surface of the processor or the heat sink.

To replace the heat sink, reverse the removal procedures.

Heat sink
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Processor
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Description

Spare part number

Intel Core i7 4785T processor, 2.2 GHz, 8-MB L3 cache, 35W

773230-001

Intel Core i7 4765T processor, 2.0 GHz, 8-MB L3 cache, 35W

754000-001

Intel Core i5 4590T processor, 2.0 GHz, 6-MB L3 cache, 35W

773228-001

Intel Core i5 4570T processor, 2.9 GHz, 4-MB L3 cache, 35W

753998-001

Intel Core i3 4330T processor, 3.0 GHz, 4-MB L3 cache, 35W

753995-001

Intel Core i3 4150T processor, 3.0 GHz, 3-MB L3 cache, 35W (ProDesk 600 models only)

773226-001

Intel Core i3 4130T processor, 2.9 GHz, 3-MB L3 cache, 35W

757416-001

Intel Pentium G3440T processor, 2.8 GHz, 3-MB L3 cache, 35W

773233-001

Intel Pentium G3420T processor, 2.7 GHz, 3-MB L3 cache, 35W

763217-001

Intel Pentium G3240T processor, 2.7 GHz, 3-MB L3 cache, 35W

773232-001

Intel Pentium G3220T processor, 2.6 GHz, 3-MB L3 cache, 35W

763216-001

Intel Celeron G1840T processor, 2.5 GHz, 2-MB L3 cache, 35W

773225-001

Intel Celeron G1820T processor, 2.4 GHz, 2-MB L3 cache, 35W

753994-001

1.

Prepare the computer for disassembly (see Preparing to disassemble the computer on page 25).

2.

Remove the access panel (see Access panel on page 26).

3.

Remove the heat sink (see Heat sink on page 43).

4.

Rotate the locking lever to its full open position (1).

5.

Raise and rotate the microprocessor retainer to its fully open position (2).

Chapter 5 Removal and Replacement Procedures

6.

Carefully lift the processor from the socket (3).
CAUTION: Do NOT handle the pins in the processor socket. These pins are very fragile and
handling them could cause irreparable damage. Once pins are damaged it may be necessary to
replace the system board.

NOTE: After installing a new processor onto the system board, always update the system ROM to
ensure that the latest version of the BIOS is being used on the computer. The latest system BIOS can be
found on the Web at: http://h18000.www.hp.com/support.

Processor
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Fan
Description

Spare part number

Fan

768424-001

The fan is located under the heat sink. It is secured with four Torx screws.
To remove the fan assembly:
1.

Prepare the computer for disassembly (see Preparing to disassemble the computer on page 25).

2.

Remove the access panel (see Access panel on page 26).

3.

Remove the heat sink (see Heat sink on page 43).

4.

Disconnect the fan cable from the system board connector labeled CHFAN (1).

5.

Remove the four Torx screws that secure the fan to the computer (2).

6.

Remove the fan from the computer.

To install the fan assembly, reverse the removal procedures.
NOTE: To avoid damaging the rubber screw grommets installed around the captive screws, when
installing the fan, push down on the fan assembly before you tighten the screws. Make sure the
grommets are positioned correctly before tightening the screws.
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Drive cage
The drive cage is located next to the heat sink. The drive cage is secured with three Phillips screws.

To remove the drive cage:
1.

Prepare the computer for disassembly (see Preparing to disassemble the computer on page 25).

2.

Remove the access panel (see Access panel on page 26).

3.

Remove the three screws (1) that secure the drive cage to the computer.

Drive cage
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4.

Lift the drive cage up and out of the computer (2).

To install the drive cage, reverse the removal procedures.
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WLAN module
Description

Spare part number

HP WLAN 802.11 a/b/g/n, 2x2

768423-001

HP WLAN 802.11 a/b/g/n, 2x2 for use in Indonesia

750552-001

The WLAN module is located near the memory modules. The WLAN module is secured with one
Phillips screw and has two connected antennas.
NOTE: WLAN module appearance may vary.

To remove the WLAN module:
1.

Prepare the computer for disassembly (see Preparing to disassemble the computer on page 25).

2.

Remove the access panel (see Access panel on page 26).

3.

Remove the drive cage (see Drive cage on page 47).

4.

Disconnect the antenna cables from the module (1).

5.

Remove the screw (2) that secures the module to the computer.

WLAN module
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6.

Lift up the top of the module, and then pull it away to remove it from the socket (3).

To install the WLAN module, reverse the removal procedures.
NOTE: WLAN modules are designed with a notch to prevent incorrect insertion.
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M.2 Solid-State Drive
Description

Spare part number

128 GB M.2 solid-state drive (SSD)

757990-001

The M.2 SSD is secured with one Phillips screw. It is located under the heat sink and fan.

To remove the M.2 SSD:
1.

Prepare the computer for disassembly (see Preparing to disassemble the computer on page 25).

2.

Remove the access panel (see Access panel on page 26).

3.

Remove the hard drive (see Hard drive on page 28).

4.

Remove the drive cage (see Drive cage on page 47).

5.

Remove the fan (see Fan on page 46).

6.

Remove the heat sink (see Heat sink on page 43).

7.

Remove the Phillips screw that secures the module to the computer.

M.2 Solid-State Drive
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8.

Lift the module to a 45-degree angle, and then pull it away to remove it from the socket.

To install the M.2 SSD, reverse the removal procedures.
NOTE: M.2 SSDs are designed with a notch to prevent incorrect insertion.
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External connection antennas (select models only)
The external connection antennas route from the WLAN module to the cable connectors on the rear of
the computer.
To install the antennas:
1.

Prepare the computer for disassembly (see Preparing to disassemble the computer on page 25).

2.

Remove the access panel (see Access panel on page 26).

3.

Remove the hard drive (see Hard drive on page 28).

4.

Remove the drive cage (see Drive cage on page 47).

5.

Remove the heat sink (see Heat sink on page 43).

6.

Remove the fan (see Fan on page 46).

7.

Using a screwdriver, pry out the two knockouts that cover the antenna cable connector holes on
the back of the computer.

External connection antennas (select models only)
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8.

Insert the cable connectors into the slots on the rear of the computer, and then fasten the
connectors using the included washer (on the inside of the chassis) and nut (on the outside of the
chassis).

9.

Connect the connector on the end of the black antenna cable to the connector labeled ‘1’ on the
WLAN module.
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10. Route the white cable using the hooks connected to the chassis.

Note the correct cable routing in the following image.

Properly installed, the white antenna routes under the fan and hard drive SATA cables.

External connection antennas (select models only)
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System board
Description

Spare part number

System boards for use in EliteDesk 800 models:
Without the Windows 8 operating system

746632-001

Windows 8 Standard

746632-501

Windows 8 Professional

746632-601

System boards for use in ProDesk 600 models:
Without the Windows 8 operating system

746722-001

Windows 8 Standard

746722-501

Windows 8 Professional

746722-601

NetClone

765381-001

The system board is secured with two Torx screws.
To remove the system board:
1.

Prepare the computer for disassembly (see Preparing to disassemble the computer on page 25).

2.

Remove the access panel (see Access panel on page 26).

3.

Remove the hard drive (see Hard drive on page 28).

4.

Remove the drive cage (see Drive cage on page 47).

5.

Remove the fan (see Fan on page 46).

6.

Remove the heat sink (see Heat sink on page 43).

7.

Remove the M.2 SSD drive (see M.2 Solid-State Drive on page 51).

8.

Remove the memory modules (see Memory on page 35).

9.

Remove the processor (see Processor on page 44).

10. Disconnect all cables from the system board, noting their location for reinstallation.
11. Remove the two Torx screws (1) that secure the system board to the computer.

System board
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12. Lift the left side of the system board, and then remove it from the computer (2).

To install the system board, reverse the removal procedures.
Updating SMBIOS Information
When replacing the system board, you must reprogram the SMBIOS information on the affected
computer. Failure to reprogram the board will result in eventual failure, such as an activation failure
(need to reactivate the system) or a system recovery failure.
To update SMBIOS information in Computer Setup:
1.

Turn on or restart the computer.

2.

Press Esc while the “Press the ESC key for Startup Menu” message is displayed at the bottom of
the screen.
NOTE: If you do not press Esc at the appropriate time, you must restart the computer and again
press Esc when the monitor light turns green to access the utility.
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3.

Press F10 to enter Computer Setup.

4.

Go to Security > System ID’s.
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5.

If necessary, press Ctrl+A to initiate edit mode.

6.

Edit the fields listed. If the feature byte has data or is not editable, then it was not cleared and
cannot be edited.

System ID Setup Page
Setup Field Name

Comment

Label

Product Name

Enter the Model name/number or marketing name.

Flexbuild

Serial Number

Enter the Serial Number of Unit.

Support

SKU Number

Enter the SKU or Product Number including Localization Code.

Support

Asset Tag

Enter the 18-byte identifier assigned to the computer.

Support

Feature Byte

Enter the Feature Byte string. The feature byte string is case sensitive.

Flexbuild

The label includes spaces after every four characters. You can enter or ignore
these spaces – their only purpose is to help with data entry. There is a
character limitation of 40 bytes per line. When you reach this limit, go to the
next line to continue data entry. BIOS ignores the spaces and lines.
If you make an error during data entry, the data will not validate, and the
computer asks you to correct your data input.
Build ID

The Build ID of the unit.

Flexbuild

System board
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WLAN antennas
Description

Spare part number

WLAN antennas

768432-001

The antennas route from the WLAN module to the cable connectors on the rear of the computer.
To install the antennas:
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1.

Prepare the computer for disassembly (see Preparing to disassemble the computer on page 25).

2.

Remove the access panel (see Access panel on page 26).

3.

Remove the hard drive (see Hard drive on page 28).

4.

Remove the drive cage (see Drive cage on page 47).

5.

Remove the heat sink (see Heat sink on page 43).

6.

Remove the fan (see Fan on page 46).

7.

Disconnect the WLAN antenna cables from the WLAN module.

8.

Remove the system board (see System board on page 57).
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9.

Remote the antenna cables from their routing paths underneath the keyboard. Note the locations
the cables are taped to the chassis as shown in the following image.

10. On the rear of the computer, remove the antenna cover by pressing on the tab on the top of the
cover (1), and then rotating the cover off the computer (2).

WLAN antennas
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11. Antenna transceivers are connected to the front and back of the computer as shown in the
following image.

12. Remove the front transceiver from the inside of the computer by pressing the tab to disengage the
transceiver and removing the transceiver (arrow in following image points to the tabs on the inside
of the computer).
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13. Remove the rear transceiver from the inside of the computer by pressing the tab to disengage the
transceiver and removing the transceiver (arrow in following image points to the tabs on the inside
of the computer).

Reverse the removal procedure to install the WLAN antennas and transceivers.

WLAN antennas
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Computer Setup (F10) Utility

Computer Setup (F10) Utilities
IMPORTANT: A connected keyboard is required to access Computer Setup.
Use Computer Setup (F10) Utility to do the following:
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●

Change factory default settings.

●

Set the system date and time.

●

Set, view, change, or verify the system configuration, including settings for processor, graphics,
memory, audio, storage, communications, and input devices.

●

Modify the boot order of bootable devices such as hard drives, optical drives, or USB flash media
devices.

●

Enable Quick Boot, which is faster than Full Boot but does not run all of the diagnostic tests run
during a Full Boot. You can set the system to:
❑

always Quick Boot (default);

❑

periodically Full Boot (from every 1 to 30 days); or

❑

always Full Boot.

●

Select Post Messages Enabled or Disabled to change the display status of Power-On Self-Test
(POST) messages. Post Messages Disabled suppresses most POST messages, such as memory
count, product name, and other non-error text messages. If a POST error occurs, the error is
displayed regardless of the mode selected. To manually switch to Post Messages Enabled during
POST, press any key (except F1 through F12).

●

Establish an Ownership Tag, the text of which is displayed each time the system is turned on or
restarted.

●

Enter the Asset Tag or property identification number assigned by the company to this computer.

●

Enable the power-on password prompt during system restarts (warm boots) as well as during
power-on.

●

Establish a setup password that controls access to the Computer Setup (F10) Utility and the settings
described in this section.
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●

Secure integrated I/O functionality, including the serial, USB, audio, or embedded NIC, so that
they cannot be used until they are unsecured.

●

Enable or disable removable media boot ability.

●

Solve system configuration errors detected but not automatically fixed during the Power-On SelfTest (POST).

●

Replicate the system setup by saving system configuration information on a USB device and
restoring it on one or more computers.

●

Execute self-tests on a specified ATA hard drive (when supported by drive).

●

Enable or disable DriveLock security (when supported by drive).

Using Computer Setup (F10) Utilities
Computer Setup can be accessed only by turning the computer on or restarting the system. To access
the Computer Setup Utilities menu, complete the following steps:
1.

Turn on or restart the computer.

2.

Repeatedly press F10 when the monitor light turns green to access the utility.
You can also press Esc to a menu that allows you to access different options available at startup,
including the Computer Setup utility.
NOTE: If you do not press F10 at the appropriate time, you must restart the computer and again
repeatedly press F10 when the monitor light turns green to access the utility.

3.

A choice of five headings appears in the Computer Setup Utilities menu: File, Storage, Security,
Power, and Advanced.

4.

Use the arrow (left and right) keys to select the appropriate heading. Use the arrow (up and down)
keys to select the option you want, then press Enter. To return to the Computer Setup Utilities
menu, press Esc.

5.

To apply and save changes, select File > Save Changes and Exit.
●

If you have made changes that you do not want applied, select Ignore Changes and
Exit.

●

To reset to factory settings or previously saved default settings (some models), select Apply
Defaults and Exit. This option will restore the original factory system defaults.

NOTE: Not all settings shown in the following sections are available for all models
CAUTION: Do NOT turn the computer power OFF while the BIOS is saving the Computer Setup
(F10) changes because the CMOS could become corrupted. It is safe to turn off the computer only after
exiting the F10 Setup screen.
Heading

Table

File

Computer Setup—File on page 66
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Storage

Computer Setup—Storage on page 67

Security

Computer Setup—Security on page 69

Power

Computer Setup—Power on page 73

Advanced

Computer Setup—Advanced on page 74

Computer Setup—File
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.
Option

Description

System Information

Lists:
●

Product name

●

Manufacturer

●

SKU number

●

Processor type/speed/stepping

●

Installed memory size/speed, number of channels

●

Integrated MAC address for embedded, enabled NIC (if applicable)

●

Chassis serial number

●

Asset tracking number

●

System Board ID

●

System Board CT Number

●

BIOS Version and Date

●

ME Firmware Version

About

Displays copyright notice.

Set Time and Date

Allows you to set system time and date.

Flash System ROM

Allows you to update the system ROM with a BIOS image file located on removable media.

Replicated Setup

Save to Removable Media
Saves system configuration to a formatted USB flash media device.
Restore from Removable Media
Restores system configuration from a USB flash media device.
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Default Setup

Save Current Settings as Default
Saves the current system configuration settings as the default.
Restore Factory Settings as Default
Restores the factory system configuration settings as the default.

Apply Defaults and
Exit

Applies the currently selected default settings and clears any established passwords.

Ignore Changes
and Exit

Exits Computer Setup without applying or saving any changes.

Save Changes and
Exit

Saves changes to system configuration or default settings and exits Computer Setup.

Computer Setup—Storage
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.
Option

Description

Device
Configuration

Lists all installed BIOS-controlled storage devices.
When a device is selected, detailed information and options are displayed. The following options
may be presented:
●

Hard Disk: Size, model, firmware version, serial number, connector color, SMART.

Computer Setup (F10) Utilities
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Storage Options

SATA Emulation
WARNING! SATA emulation changes may prevent access to existing hard drive data and
degrade or corrupt established volumes.
Allows you to choose how the SATA controller and devices are accessed by the operating system.
There are two supported options: IDE and AHCI (default).
CAUTION: SATA emulation changes may prevent access to existing hard drive data and
degrade or corrupt established volumes.
IDE - This is the most backwards-compatible setting of the three options. Operating systems usually
do not require additional driver support in IDE mode.
AHCI (default option) - Allows operating systems with AHCI device drivers loaded to take
advantage of more advanced features of the SATA controller.
Removable Media Boot
Enables/disables ability to boot the system from removable media. Default is enabled.

Boot Order

Allows you to:
●

EFI Boot Sources: Specify the order in which EFI boot sources (such as a internal hard drive,
USB hard drive, USB optical drive, or internal optical drive) are checked for a bootable
operating system image. Each device on the list may be individually excluded from or included
for consideration as a bootable operating system source.
EFI boot sources always have precedence over legacy boot sources.

●

Legacy Boot Sources: Specify the order in which legacy boot sources (such as a network
interface card, internal hard drive, USB optical drive, or internal optical drive) are checked for
a bootable operating system image. Each device on the list may be individually excluded from
or included for consideration as a bootable operating system source.
Specify the order of attached hard drives. The first hard drive in the order will have priority in
the boot sequence and will be recognized as drive C (if any devices are attached).

NOTE: To drag a device to a preferred place, press Enter. To remove the device from
consideration as a bootable device, press F5.
You can use F5 to disable individual boot items, as well as disable EFI boot and/or legacy boot.
NOTE: MS-DOS drive lettering assignments may not apply after a non-MS-DOS operating system
has started.
Shortcut to Temporarily Override Boot Order
To boot one time from a device other than the default device specified in Boot Order, restart the
computer and press Esc (to access the boot menu) and then F9 (Boot Order), or only F9 (skipping
the boot menu) when the monitor light turns green. After POST is completed, a list of bootable
devices is displayed. Use the arrow keys to select the preferred bootable device and press Enter.
The computer then boots from the selected non-default device for this one time.
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Computer Setup—Security
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.
Option

Description

Setup Password

Allows you to set and enable a setup (administrator) password.
NOTE: If the setup password is set, it is required to change Computer Setup options, flash the
ROM, and make changes to certain plug and play settings under Windows.

Power-On
Password

Allows you to set and enable a power-on password. The power-on password prompt appears after
a power cycle or reboot. If the user does not enter the correct power-on password, the unit will not
boot.

Password Options

Allows you to enable/disable:

(This selection appears
only if a power-on
password or setup
password is set.)

●

Lock Legacy Resources (determines whether or not Windows Device Manager is allowed to
change resource settings for serial and parallel ports).

●

Setup Browse Mode (appears if a setup password is set) (allows viewing, but not changing,
the F10 Setup Options without entering setup password). Default is enabled.

●

Password prompt on F9, F11 & F12 (requires setup password to use these boot functions).
Default is enabled.

●

Network Server Mode. Default is disabled.

●

Stringent Password (enabling the stringent password disables the ability to reset the password
by moving the jumper on the system board). Default is disabled.
CAUTION: If you enable the stringent security feature and you forget the setup password or
the power-on password, the computer is inaccessible and can no longer be used.
If you lose or forget the password, the system board must be replaced. This scenario is not
covered under warranty.
To prevent the computer from becoming permanently unusable, record your configured setup
password or power-on password in a safe place away from your computer. Without these
passwords, the computer cannot be unlocked.

Device Security

Allows you to set Device Available/Device Hidden (default is Device Available) for:
●

Embedded Security Device

●

System audio

●

Network controller
NOTE:

●
USB Security

You must disable AMT before trying to hide the network controller.

SATA ports (varies by model)

Allows you to set Enabled/Disabled (default is Enabled) for:
●

Front USB Ports

●

Rear USB Ports

●

Accessory USB Ports

Computer Setup (F10) Utilities
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Slot Security

Allows you to disable any PCI Express slot. Default is enabled.

Network Boot

Enables/disables the computer’s ability to boot from an operating system installed on a network
server. (Feature available on NIC models only; the network controller must be either a PCI
expansion card or embedded on the system board.) Default is enabled.

System IDs

Allows you to set:

Master Boot Record
Security

●

Asset tag (18-byte identifier), a property identification number assigned by the company to the
computer.

●

Ownership tag (80-byte identifier) displayed during POST.

●

Universal Unique Identifier (UUID) number. The UUID can only be updated if the current
chassis serial number is invalid. (These ID numbers are normally set in the factory and are used
to uniquely identify the system.)

●

Keyboard Layout (language).

Enables/disables Master Boot Record (MBR) security.
The MBR contains information needed to successfully boot from a disk and to access the data stored
on the disk. Master Boot Record Security may prevent unintentional or malicious changes to the
MBR, such as those caused by some viruses or by the incorrect use of certain disk utilities. It also
allows you to recover the "last known good" MBR, should changes to the MBR be detected when
the system is restarted.
When MBR Security is enabled, the BIOS prevents any changes being made to the MBR of the
current bootable disk while in MS-DOS or Windows Safe Mode.
NOTE: Most operating systems control access to the MBR of the current bootable disk; the BIOS
cannot prevent changes that may occur while the operating system is running.
Restores the backup Master Boot Record to the current bootable disk. Default is disabled.
Only appears if all of the following conditions are true:
●

MBR security is enabled

●

A backup copy of the MBR has been previously saved

●

The current bootable disk is the same disk from which the backup copy was saved

CAUTION: Restoring a previously saved MBR after a disk utility or operating system has modified
the MBR, may cause the data on the disk to become inaccessible. Only restore a previously saved
MBR if you are confident that the current bootable disk's MBR has been corrupted or infected with a
virus.
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System Security
(these options are
hardware dependent)

Data Execution Prevention (enable/disable) - Helps prevent operating system security breaches.
Default is enabled.
Virtualization Technology (VTx) (enable/disable) - Controls the virtualization features of the
processor. Changing this setting requires turning the computer off and then back on. Default is
disabled.
Embedded Security Device (enable/disable) - This option becomes available if Embedded Device is
set to Available. Embedded Security Device turns the Trusted Platform Mechanism (TPM) on and off.
●

Reset to Factory Settings (reset/do not reset) - Enabling this option will clear any saved data in
the TPM and set the TPM back to factory default settings.
Resetting to factory defaults will erase all security keys and leave the device in a disabled
state. Changing this setting requires that you restart the computer. Default is Do not reset.
CAUTION: The embedded security device is a critical component of many security schemes.
Erasing the security keys will prevent access to data protected by the Embedded Security
Device. Choosing Reset to Factory Settings may result in significant data loss.

●

Measure boot variables/devices to PCR1 (enable/disable) - Enabling this option will allow the
operating system to log boot variables/devices to PCR1 instead of PCR5.
Typically, the computer measures the boot path and saves collected metrics to PCR5 (a register
in the Embedded Security Device). Bitlocker tracks changes to any of these metrics, and forces
the user to re-authenticate if it detects any changes. Enabling this feature lets you set Bitlocker
to ignore detected changes to boot path metrics, thereby avoiding re-authentication issues
associated with USB keys inserted in a port. Default is enabled.

To enable the Embedded Security Device and to access any security features associated with the
device, you must enter a setup password. Setting a device to ‘Available’ enables the operating
system to access the device. ‘Hidden’ makes the device unavailable, meaning it is disabled by the
BIOS and cannot be enabled by the operating system.
OS management of Embedded Security Device - Enables or disables the ability of the operating
system to control the TPM device, including turning it on and off, initializing it, and resetting it.
●

Reset of Embedded Security Device through OS¯ (enable/disable) - This option allows the user
to limit the operating system ability to request a Reset to Factory Settings of the Embedded
Security Device. Default is disabled.

●

No PPI provisioning (enable/disable) - This option lets to set Windows 8 to bypass the PPI
(Physical Presence Interface) requirement and directly enable and take ownership of the TPM
on first boot. End-user cannot change this setting after TPM is owned/initialized, unless the
TPM is reset. Default is disabled for non-Windows 8 systems, and enabled for Windows 8.

●

Allow PPI policy to be changed by OS (enable/disable) - Enabling this option allows the
operating system to execute TPM operations without Physical Presence Interface. Default is
disabled.
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DriveLock Security

Allows you to assign or modify a master or user password for hard drives. When this feature is
enabled, the user is prompted to provide one of the DriveLock passwords during POST. If neither is
successfully entered, the hard drive will remain inaccessible until one of the passwords is
successfully provided during a subsequent cold-boot sequence.
NOTE: This selection will only appear when at least one drive that supports the DriveLock feature
is attached to the system.

Secure Boot
Configuration

●

Legacy Support—Enable/Disable. Allows you to turn off all legacy support on the computer,
including booting to DOS, running legacy graphics cards, booting to legacy devices, and so
on. If set to disable, legacy boot options in Storage > Boot Order are not displayed.
Default is enabled.

●

Secure Boot—Enable/Disable. Allows you to make sure an operating system is legitimate
before booting to it, making Windows resistant to malicious modification from preboot to full
OS booting, preventing firmware attacks. UEFI and Windows Secure Boot only allow code
signed by pre-approved digital certificates to run during the firmware and OS boot process.
Default is disabled, except for Windows 8 systems which have this setting enabled. Secure
Boot enabled also sets Legacy Support to disabled.

●

Key Management—This option lets you manage the custom key settings.

●

◦

Clear Secure Boot Keys—Don't Clear/Clear. Allows you to delete any previously loaded
custom boot keys. Default is Don't Clear.

◦

Key Ownership—HP Keys/Custom Keys. Selecting Custom Mode allows you to modify
the contents of the secure boot signature databases and the platform key (PK) that verifies
kernels during system start up, allowing you to use alternative operating systems.
Selecting HP Keys causes the computer boot using the preloaded HP-specific boot keys.
Default is HP Keys.

Fast Boot—Enable/Disable. Fast boot disables the ability to interrupt boot, such as pressing f
keys to access items before the operating system loads. Default is disabled.
NOTE: If Windows 8 detects a serious error, it will interrupt the boot process automatically
and display advanced boot options.
From Windows 8, you can press Shift and select Restart to access the screen that lets you
boot to a device or troubleshoot your computer.
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Computer Setup—Power
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.
Option

Description

OS Power
Management

●

Runtime Power Management— Enable/Disable. Allows certain operating systems to reduce
processor voltage and frequency when the current software load does not require the full
capabilities of the processor. Default is enabled.

●

Idle Power Savings—Extended/Normal. Allows certain operating systems to decrease the
processors power consumption when the processor is idle. Default is extended.

●

Unique Sleep State Blink Rates—Enable/Disable. This feature is designed to provide a visual
indication of what sleep state the system is in. Each sleep state has a unique blink pattern.
Default is disabled.
NOTE: For Windows 8 systems with Fast Boot support, a normal shutdown goes to the S4
state, not the S5 state.

Hardware Power
Management

◦

S0 (On) = Solid white LED.

◦

S3 (Stand By)= 3 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(white LED) — repeated cycles of 3 blinks and a pause.

◦

S4 (Hibernation)= 4 blinks at 1Hz (50% duty cycle) followed by a pause of 2 seconds
(white LED) — repeated cycles of 4 blinks and a pause.

◦

S5 (Soft Off) = LED is off.

SATA Power Management – Enables or disables SATA bus and/or device power management.
Default is enabled.
S5 Maximum Power Savings – Turns off power to all nonessential hardware when system is off to
meet EUP Lot 6 requirement of less than 0.5 Watt power usage. Default is disabled.
PCI Express Power Management – Sets Active State Power Management (ASPM) of the bus. ASPM
lets you set lower power modes that activate when the bus is not being used. Default is enabled.

Thermal

Fan idle mode—This bar graph controls the minimum permitted fan speed.
NOTE: This setting only changes the minimum fan speed. The fans are still automatically
controlled.
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Computer Setup—Advanced
NOTE: Support for specific Computer Setup options may vary depending on the hardware
configuration.
Option

Heading

Power-On Options

Allows you to set:
●

POST mode (QuickBoot, Clear Memory, FullBoot, or FullBoot Every x Days).
◦

QuickBoot (default) = Do not clear memory or perform a memory test.

◦

FullBoot = Memory test (count) on cold boot. Clears memory on all boots.

◦

Clear Memory = No memory count on cold boot. Clears memory on all boots.

◦

FullBoot Every x Days = Memory count on 1st cold boot on or after the xth day. No more
memory counts until 1st cold boot on or after x days. Clears memory on all boots.

●

POST messages (enable/disable). Enabling this feature will cause the system to display POST
error messages, which are error messages displayed on the monitor during the Power On Self
Test if the BIOS encounters some kind of problem while starting the PC. A POST error message
will only display on screen if the computer is capable of booting this far. If the POST detects
an error before this point, a beep code is generated instead. Default is disabled.

●

Press the ESC key for Startup Menu (Enable/Disable). This feature controls the display of the
text “Press the ESC key for Startup Menu” during POST. This text does not display on
Windows 8 systems with Fast Boot support. Other text also will not display (for example,
Ownership Tag). Default is enabled.

●

Option ROM Prompt (enable/disable). Enabling this feature will cause the system to display a
message before loading option ROMs. Default is enabled.

●

After Power Loss (off/on/previous state). Default is Power off. Setting this option to:
◦

Power off—causes the computer to remain powered off when power is restored.

◦

Power on—causes the computer to power on automatically as soon as power is restored.

◦

Previous state—causes the computer to power on automatically as soon as power is
restored, if it was on when power was lost.

NOTE: If you turn off power to the computer using the switch on a power strip, you will not be
able to use the suspend/sleep feature or the Remote Management features.
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●

POST Delay (in seconds). Enabling this feature will add a user-specified delay to the POST
process. This delay is sometimes needed for hard disks on some PCI cards that spin up very
slowly, so slowly that they are not ready to boot by the time POST is finished. The POST delay
also gives you more time to select F10 to enter Computer (F10) Setup. Default is None.

●

Remote Wakeup Boot Source (remote server/local hard drive). Default is Local hard drive.

●

Factory Recovery Boot Support (Enable/Disable). Provides the ability for the BIOS to redirect
the boot to the recovery partition on the user hard drive, if present. Some versions of the
recovery software honor the F11 key press even when this feature is disabled by the BIOS.
Default is disabled.

●

Bypass F1 Prompt on Configuration Changes (Enable/Disable). Allows you to set the computer
not to confirm when changes were made. Default is disabled.

●

POST Memory Manager Runtime Allocation (Enable/Disable). Default is disabled.

BIOS Power-On

Allows you to set the computer to turn on automatically at a time you specify.

Onboard Devices

Allows you to set resources for or disable Legacy devices.
Select the Legacy device's IRQ, DMA, and I/O Range. The settings may not take effect for all
operating systems. To hide a device from the operating system, see Security > Device Security.

Bus Options

Device Options

Allows you to enable or disable:
●

PCI SERR# Generation. Default is enabled.

●

PCI VGA Palette Snooping, which sets the VGA palette snooping bit in PCI configuration
space; only needed when more than one graphics controller is installed. Default is disabled.

Allows you to set:
●

Num Lock State at Power-On (off/on). Default is off.

●

Internal Speaker (does not affect external speakers). Default is enabled.

●

Multi-Processor (enable/disable). Use this option to disable multi-processor support under the
OS. Default is enabled.

●

USB Charging Port (enable/disable). Default is enabled.

●

USB 3.0 BIOS Driver Support (enabled/disabled). Default is disabled.

●

Hyper threading (enable/disable). Use this option to disable processor hyper-threading.

Computer Setup (F10) Utilities
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Management
Operations

AMT (enable/disable). Allows you to enable or disable functions of the embedded Management
Engine (ME) such as Active Management Technology (AMT). If set to disable, the Management
Engine is set to a temporarily disabled state and will not provide functions beyond necessary system
configuration. Default is enabled.
Unconfigure AMT/ME (enable/disable). Allows you to unconfigure any provisioned management
settings for AMT. The AMT settings are restored to factory defaults. This feature should be used with
caution as AMT will not be able to provide any set AMT management functions once unconfigured.
Default is disabled.
Hide Unconfigure ME Confirmation Prompt (enable/disable). Allows you to set the system to not
display the confirmation to unconfigure ME.
Watchdog Timer (enable/disable). Allows you to set amount of time for a operating system and
BIOS watchdog alert to be sent if the timers are not deactivated. BIOS watchdog is deactivated by
BIOS and would indicate that a halt occurred during execution if the alert is sent to the
management console. An operating system alert is deactivated by the operating system image and
would indicate that a hang occurred during its initialization. Default is enabled.

Option ROM Launch
Policy

Connected BIOS

(Windows 8 only). Windows 8 installs as a UEFI operating system (as opposed to ‘legacy’), and
ships with the ‘Legacy Support’ setting off in the BIOS. When ‘Legacy Support’ is off, the Option
ROM Launch Policies are set to ‘UEFI Only’. These policies control whether the Legacy Option ROM
or the UEFI driver is loaded for the following features:
●

PXE Option ROMs (UEFI Only/Do Not Launch). Specifies whether the legacy option ROM or
the UEFI driver in the BIOS is used to provide PXE services.

●

Storage Option ROMs (UEFI Only/Do Not Launch). Specifies whether the legacy option ROM
or the UEFI driver in the BIOS is used to provide RAID setup and support.

●

Video Option ROMs (UEFI Only/Do Not Launch). Specifies whether the legacy VBIOS or the
UEFI driver in the BIOS is used to provide graphics setup and support.

Connected BIOS (enable/disable) - Lets you configure a proxy server from which to get updates to
the BIOS. If set to enabled, the Use Proxy option displays.
Use Proxy (enable/disable) - Lets you enter a proxy server address. If set to enabled, the Proxy
Address field displays.
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Update BIOS via
Network

Update BIOS via Network (enable/disable) – Lets you update the BIOS over a network. Default is
enabled.
Update Source (HP/Custom) - If Custom is selected, the Update Address field displays.
Automatic BIOS Update Setting (Disabled/Check and install all updates automatically/Check and
install only important updates automatically) - If set to update automatically, you can set the
frequency to Daily, Weekly, or Month using the Automatic Update option. You can also use the
Force Check on Next Reboot option to have the system check for an updated BIOS the next
time it reboots.

Ethernet Connection

NIC Configuration
- Link Speed - Lets you specify the link speed, or let it be determined automatically.
- Wake on LAN - Lets you enable or disable wake-on LAN.
Blink LEDs - Let you manually enter the number of times the ethernet connection LED blinks.
PORT CONFIGURATION INFORMATION - displays the following:
●

UEFI driver

●

Adapter PBA

●

Chip Type

●

PCI Device ID

●

Bus:Device:Function

●

Link Status

●

MAC address

Recovering the Configuration Settings
This method of recovery requires that you first perform the Save to Removable Media command
with the Computer Setup (F10) Utility before Restore is needed. (See Computer Setup—File
on page 66 in the Computer Setup—File table.)
NOTE: It is recommended that you save any modified computer configuration settings to a USB flash
media device and save the device for possible future use.
To restore the configuration, insert the USB flash media device with the saved configuration and
perform the Restore from Removable Media command with the Computer Setup (F10) Utility.
(See Computer Setup—File on page 66 in the Computer Setup—File table.)

Recovering the Configuration Settings
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HP PC Hardware Diagnostics

To help troubleshoot and diagnose failures, use the UEFI-based hardware diagnostic solution that HP
includes on all products. This tool can even be used if the computer will not boot to the operating
system.

Why run HP PC Hardware Diagnostics – UEFI
The HP PC Hardware Diagnostic tools simplify the process of diagnosing hardware issues and expedite
the support process when issues are found. The tools save time by pinpointing the component that
needs to be replaced.
●

Isolate true hardware failures: The diagnostics run outside of the operating system so they
effectively isolate hardware failures from issues that may be caused by the operating system or
other software components.

●

Failure ID: When a failure is detected that requires hardware replacement, a 24-digit Failure ID
is generated. This ID can then be provided to the call agent, who will either schedule support or
provide replacement parts.

How to access and run HP PC Hardware Diagnostics
- UEFI
To access the UEFI diagnostics:
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1.

Restart or turn on the computer and press Esc repeatedly until the BIOS boot menu appears.

2.

Press F2 or select Diagnostics (F2).
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After pressing F2, the BIOS sequentially searches three places for the system diagnostics:
a.

First – a connected USB drive (to download the diagnostics tools to a USB drive, see the
instructions in Downloading HP PC Hardware Diagnostics to a USB device on page 79).

b.

Second – the hard disk drive.

c.

Third – in the BIOS, a core set of diagnostics (for memory and hard disk drive) that are
accessible only if the USB or hard disk drive versions are not detected.

Downloading HP PC Hardware Diagnostics to a USB
device
1.

Go to http://www.hp.com.

2.

Click the Support & Drivers link.

3.

Select the Drivers & Software tab.

4.

Enter the product name in the text box and click Search.

5.

Select your specific computer model.

6.

Select your operating system.

7.

In the Diagnostic section, click the HP UEFI Support Environment link. This link provides
additional information.
- or Click the Download button and select Run. The download includes instructions (in English) on
how to install the tools on the USB device.

NOTE: HP diagnostic solutions are developed to test components typically included on HP products.
They may not diagnose all third-party accessories that can be added to the system.

Downloading HP PC Hardware Diagnostics to a USB device
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Troubleshooting Without
Diagnostics

This chapter provides information on how to identify and correct minor problems, such as USB devices,
hard drive, optical drive, graphics, audio, memory, and software problems. If you encounter problems
with the computer, refer to the tables in this chapter for probable causes and recommended solutions.
NOTE: For information on specific error messages that may appear on the screen during Power-On
Self-Test (POST) at startup, refer to Appendix A, POST Error Messages on page 131.

Safety and Comfort
WARNING! Misuse of the computer or failure to establish a safe and comfortable work environment
may result in discomfort or serious injury. Refer to the Safety & Comfort Guide at http://www.hp.com/
ergo for more information on choosing a workspace and creating a safe and comfortable work
environment. For more information, refer to the Safety & Regulatory Information guide.

Before You Call for Technical Support
If you are having problems with the computer, try the appropriate solutions below to try to isolate the
exact problem before calling for technical support.
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●

Run the HP diagnostic tool.

●

Run the hard drive self-test in Computer Setup. Refer to Computer Setup (F10) Utility on page 64
for more information.

●

Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are
error codes that will help you diagnose the problem. Refer to Appendix A, POST Error Messages
on page 131 for more information.

●

If the screen is blank, plug the monitor into a different video port on the computer if one is
available. Or, replace the monitor with a monitor that you know is functioning properly.

●

If you are working on a network, plug another computer with a different cable into the network
connection. There may be a problem with the network plug or cable.

●

If you recently added new hardware, remove the hardware and see if the computer functions
properly.
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●

If you recently installed new software, uninstall the software and see if the computer functions
properly.

●

Boot the computer to the Safe Mode to see if it will boot without all of the drivers loaded. When
booting the operating system, use “Last Known Configuration.”

●

Refer to the comprehensive online technical support at http://www.hp.com/support.

●

Refer to Helpful Hints on page 81 in this guide.

To assist you in resolving problems online, HP Instant Support Professional Edition provides you with
self-solve diagnostics. If you need to contact HP support, use HP Instant Support Professional Edition's
online chat feature. Access HP Instant Support Professional Edition at: http://www.hp.com/go/ispe.
Access the Business Support Center (BSC) at http://www.hp.com/go/bizsupport for the latest online
support information, software and drivers, proactive notification, and worldwide community of peers
and HP experts.
If it becomes necessary to call for technical assistance, be prepared to do the following to ensure that
your service call is handled properly:
●

Be in front of your computer when you call.

●

Write down the computer serial number, product ID number, and monitor serial number before
calling.

●

Spend time troubleshooting the problem with the service technician.

●

Remove any hardware that was recently added to your system.

●

Remove any software that was recently installed.

●

Restore the system from the Recovery Disc Set that you created or restore the system to its original
factory condition in System Software Requirement Disks (SSRD).

CAUTION: Restoring the system will erase all data on the hard drive. Be sure to back up all data
files before running the restore process.
NOTE: For sales information and warranty upgrades (Care Packs), call your local authorized service
provider or dealer.

Helpful Hints
If you encounter problems with the computer, monitor, or software, see the following list of general
suggestions before taking further action:
●

Check that the computer and monitor are plugged into a working electrical outlet.

●

Check that the voltage select switch (some models) is set to the appropriate voltage for your region
(115V or 230V).

●

Check that the computer is turned on and the white power light is on.

●

Check that the monitor is turned on and the green monitor light is on.

Helpful Hints
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●

Check the Power LED on the front of the computer to see if it is flashing red. The flashing lights are
error codes that will help you diagnose the problem. Refer to Appendix A, POST Error Messages
on page 131 for more information.

●

Turn up the brightness and contrast controls of the monitor if the monitor is dim.

●

Press and hold any key. If the system beeps, then the keyboard should be operating correctly.

●

Check all cable connections for loose connections or incorrect connections.

●

Wake the computer by pressing any key on the keyboard or pressing the power button. If the
system remains in suspend mode, shut down the computer by pressing and holding the power
button for at least four seconds then press the power button again to restart the computer. If the
system will not shut down, unplug the power cord, wait a few seconds, then plug it in again. The
computer will restart if it is set to power on automatically as soon as power is restored in
Computer Setup. If it does not restart, press the power button to start the computer.

●

Reconfigure the computer after installing a non-plug and play expansion board or other option.
See Solving Hardware Installation Problems on page 105 for instructions.

●

Be sure that all the needed device drivers have been installed. For example, if you are using a
printer, you need a driver for that model printer.

●

Remove all bootable media (CD/DVD or USB device) from the system before turning it on.

●

If you have installed an operating system other than the factory-installed operating system, check
to be sure that it is supported on the system.

●

If the system has multiple video sources (embedded, PCI, or PCI-Express adapters) installed
(embedded video on some models only) and a single monitor, the monitor must be plugged into
the monitor connector on the source selected as the primary VGA adapter. During boot, the other
monitor connectors are disabled and if the monitor is connected into these ports, the monitor will
not function. You can select which source will be the default VGA source in Computer Setup.

CAUTION: When the computer is plugged into an AC power source, there is always voltage
applied to the system board. You must disconnect the power cord from the power source before
opening the computer to prevent system board or component damage.

82

Chapter 8 Troubleshooting Without Diagnostics

Solving General Problems
You may be able to easily resolve the general problems described in this section. If a problem persists
and you are unable to resolve it yourself or if you feel uncomfortable about performing the operation,
contact an authorized dealer or reseller.
WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.
Table 8-1 Solving General Problems
Computer appears locked up and will not turn off when the power button is pressed.
Cause

Solution

Software control of the power switch is not functional.

1.

Press and hold the power button for at least four seconds
until the computer turns off.

2.

Disconnect the power cord from the electrical outlet.

Computer will not respond to keyboard or mouse.
Cause

Solution

Computer is in Sleep state.

To resume from Sleep state, press the power button.
CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

System has locked up.

Restart computer.

Computer date and time display is incorrect.
Cause

Solution

RTC (real-time clock) battery may need to be replaced.

Reset the date and time under Control Panel (Computer
Setup can also be used to update the RTC date and time). If
the problem persists, replace the RTC battery. See the
Removal and Replacement section for instructions on installing
a new battery, or contact an authorized dealer or reseller for
RTC battery replacement.

NOTE: Connecting the computer to a live AC outlet
prolongs the life of the RTC battery.

To access Control Panel in Windows 7, select Start, and then
select Control Panel.
To access Control Panel in Windows 8, from the Start screen,
type c, and then select Control Panel from the list of
applications.
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Cursor will not move using the arrow keys on the keypad.
Cause

Solution

The Num Lock key is turned on.

Press the Num Lock key. The Num Lock light must be off if you
want to use the arrow keys on the keypad. You can also
disable or enable the Num Lock key in Computer Setup at
Advanced > Device Options.

There is no sound or sound volume is too low.
Cause

Solution

System volume may be set low or muted.

1.

Check the Computer Setup settings to make sure the
internal system speaker is not muted (this setting does not
affect the external speakers).

2.

Make sure the external speakers are properly connected
and powered on and that the speakers' volume control is
set correctly.

3.

Use the system volume control available in the operating
system to make sure the speakers are not muted or to
increase the volume.

Cannot remove computer cover or rear cover.
Cause

Solution

Smart Cover Lock, featured on some computers, is locked.

Unlock the Smart Cover Lock using Computer Setup.
In case of forgotten password, power loss, or computer
malfunction, you must manually disable the Smart Cover lock .
A key to unlock the Smart Cover Lock is not available from
HP. Keys are typically available from a hardware store.

Poor performance.

84

Cause

Solution

Processor is too hot.

1.

Make sure airflow to the computer is not blocked. Leave
a 10.2-cm (4-inch) clearance on all vented sides of the
computer and above the monitor to permit the required
airflow.

2.

Make sure fans are connected and working properly
(some fans only operate when needed).

3.

Make sure the processor heat sink is installed properly.

Hard drive is full.

Transfer data from the hard drive to create more space on the
hard drive.

Low on memory.

Add more memory.
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Table 8-1 Solving General Problems (continued)
Poor performance.
Cause

Solution

Hard drive fragmented.

Defragment hard drive.

Program previously accessed did not release reserved memory
back to the system.

Restart the computer.

Virus resident on the hard drive.

Run virus protection program.

Too many applications running.

Windows 7:
1.

Close unnecessary applications to free up memory.

2.

Add more memory.

3.

Some applications run in the background and can be
closed by right-clicking on their corresponding icons in
the task tray. To prevent these applications from
launching at startup:
In Windows 7:
a.

Go to Start > All Programs > Accessories >
Run

b.

Type msconfig, and then press Enter.

c.

On the Startup tab of the System Configuration
Utility, clear applications that you do not want to
launch automatically, and the click OK.

In Windows 8:

Some software applications, especially games, are stressful on
the graphics subsystem.

Cause unknown.

a.

On the Start screen, right-click, and then select the
All apps icon.

b.

Under Windows System, click Run.

c.

Type msconfig, and then press Enter.

d.

On the Startup tab of the System Configuration
Utility, clear applications that you do not want to
launch automatically, and the click OK.

1.

Lower the display resolution for the current application or
consult the documentation that came with the application
for suggestions on how to improve performance by
adjusting parameters in the application.

2.

Add more memory.

3.

Upgrade the graphics solution.

Restart the computer.
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Computer powered off automatically and the Power LED flashes Red two times, once every second,
followed by a two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but
LEDs continue flashing).
Cause

Solution

Processor thermal protection activated:

1.

Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2.

Open the rear cover, press the power button, and see if
the processor fan (or other system fan) spins. If the fan
does not spin, make sure the fan cable is plugged onto
the system board header.

3.

If fan a plugged in and not spinning, replace it.

A fan may be blocked or not turning.
OR
The heat sink is not properly attached to the processor.

System does not power on and the LEDs on the front of the computer are not flashing.
Cause

Solution

System unable to power on.

Press and hold the power button for less than 4 seconds. If the
hard drive LED turns white, then:
1.

If equipped with a voltage selector, check that the
voltage selector (located on the rear of the power supply)
is set to the appropriate voltage. Proper voltage setting
depends on your region.

2.

Remove the expansion cards one at a time until the
5V_aux light on the system board turns on.

3.

Replace the system board.

OR
Press and hold the power button for less than 4 seconds. If the
hard drive LED does not turn on white then:
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1.

Check that the unit is plugged into a working AC outlet.

2.

Open the rear cover and check that the power button
cable is properly connected to the system board.

3.

Check that the power supply cables are properly
connected to the system board.

4.

Check to see if the 5V_aux light on the system board is
turned on. If it is turned on, then replace the power
button assembly.

5.

If the 5V_aux light on the system board is off, then
replace the power supply.

6.

Replace the system board.

Solving Power Problems
Common causes and solutions for power problems are listed in the following table.
Table 8-2 Solving Power Problems
Power supply shuts down intermittently.
Cause

Solution

If equipped with a voltage selector, voltage selector switch on
rear of computer chassis (some models) not switched to
correct line voltage (115V or 230V).

Select the proper AC voltage using the selector switch.

Power supply will not turn on because of internal power
supply fault.

Replace the power supply.

Computer powered off automatically and the Power LED flashes Red two times, once every second,
followed by a two second pause, and the computer beeps two times. (Beeps stop after fifth iteration but
LEDs continue flashing.)
Cause

Solution

Processor thermal protection activated:

1.

Ensure that the computer air vents are not blocked and
the processor cooling fan is running.

2.

Open the rear cover, press the power button, and see if
the processor fan (or other system fan) spins. If the fan
does not spin, make sure the fan cable is plugged onto
the system board header.

3.

If fan a plugged in and not spinning, replace it.

A fan may be blocked or not turning.
OR
The heat sink is not properly attached to the processor.
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Power LED flashes Red four times, once every second, followed by a two second pause, and the
computer beeps four times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Power failure (power supply is overloaded).

1.

If equipped with a voltage selector, check that the
voltage selector, located on the rear of the power supply
(some models), is set to the appropriate voltage. Proper
voltage setting depends on your region.

2.

Open the rear cover and ensure the power supply cable
is seated into the connector on the system board.

3.

Check if a device is causing the problem by removing
ALL attached devices (such as hard drives or optical
drives and expansion cards). Power on the system. If the
system enters POST, then power off and replace one
device at a time and repeat this procedure until failure
occurs. Replace the device that is causing the failure.
Continue adding devices one at a time to ensure all
devices are functioning properly.

4.

Replace the power supply.

5.

Replace the system board.

The incorrect external power supply adapter is being
used
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The power supply adapter must be at the correct power rating
and use the Smart ID technology before the system will power
up. Replace the power supply adapter with the HP-supplied
power supply adapter.

Solving Hard Drive Problems
Table 8-3 Solving Hard Drive Problems
Hard drive error occurs.
Cause

Solution

Hard disk has bad sectors or has failed.

1.

In Windows 7, click Start, click Computer, and rightclick on a drive. Select Properties, and then select the
Tools tab. Under Error-checking click Check Now.
In Windows 8, on the Start screen type e, and then
select File Explorer from the list of applications. In the
left column, expand Computer, right-click on a drive,
select Properties, and then select the Tools tab. Under
Error checking click Check.

2.

Use a utility to locate and block usage of bad sectors. If
necessary, reformat the hard disk.

Disk transaction problem.
Cause

Solution

Either the directory structure is bad or there is a problem with
a file.

In Windows 7, click Start, expand Computer, and rightclick on a drive. Select Properties, and then select the
Tools tab. Under Error-checking click Check Now.
In Windows 8, on the Start screen type e, and then click File
Explorer from the list of applications. In the left column,
expand Computer, right-click on a drive, select Properties,
and then select the Tools tab. Under Error checking click
Check.

Drive not found (identified).
Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 105 section. If the system still
does not recognize the new device, check to see if the device
is listed within Computer Setup. If it is listed, the probable
cause is a driver problem. If it is not listed, the probable cause
is a hardware problem.
If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > PowerOn Options.

Solving Hard Drive Problems
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Table 8-3 Solving Hard Drive Problems (continued)
Drive not found (identified).
Cause

Solution

The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.

Nonsystem disk/NTLDR missing message.
Cause

Solution

The system is trying to start from the hard drive but the hard
drive may have been damaged.

1.

Perform Drive Protection System (DPS) testing in system
ROM.

System files missing or not properly installed.

1.

Insert bootable media and restart the computer.

2.

Boot to the windows installation media and select the
recovery option. If only a restore kit is available, then
select the File Backup Program option, and then
restore the system.

3.

Install system files for the appropriate operating system.

Hard drive boot has been disabled in Computer Setup.

Run the Computer Setup utility and enable the hard drive entry
in the Storage > Boot Order list.

Bootable hard drive is not attached as first in a multi-hard
drive configuration.

If attempting to boot from a hard drive, ensure it is attached to
the system board dark blue SATA connector.

Bootable hard drive is not listed first in the Boot Order.

Run the Computer Setup utility and select Storage > Boot
Order and ensure the bootable hard drive is listed
immediately under the Hard Drive entry.

Computer will not boot from hard drive.
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Cause

Solution

The device is attached to a SATA port that has been hidden in
Computer Setup.

1.

Check SATA cable connections.

2.

Run the Computer Setup utility and ensure Device
Available is selected for the device's SATA port in
Security > Device Security.

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.
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Table 8-3 Solving Hard Drive Problems (continued)
Computer will not boot from hard drive.
Cause

Solution

Hard Drive's “Emulation Type” is set to “None.” (some
models)

Run the Computer Setup utility and change the “Emulation
Type” to “Hard Disk” in the device's details under Storage >
Device Configuration.

Hard drive is damaged.

Observe if the front panel Power LED is blinking RED and if
any beeps are heard. See Appendix A, POST Error Messages
on page 131 to determine possible causes for the blinking
red and beep codes.
See the Worldwide Limited Warranty for terms and
conditions.

Computer seems to be locked up.
Cause

Solution

Program in use has stopped responding to commands.

1.

Use the task manager to close programs that do not
respond.

2.

Attempt the normal Windows “Shut Down” procedure. If
this fails, press the power button for four or more
seconds to turn off the power. To restart the computer,
press the power button again.
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Solving Media Card Reader Problems
Table 8-4 Solving Media Card Reader Problems
Media card will not work in a digital camera after formatting it in Windows.
Cause

Solution

By default, Windows will format any media card with a
capacity greater than 32MB with the FAT32 format. Some
digital cameras use the FAT (FAT16 & FAT12) format and can
not operate with a FAT32 formatted card.

Either format the media card in the digital camera or select
FAT file system to format the media card in a computer with
Windows.

A write-protected or locked error occurs when attempting to write to the media card.
Cause

Solution

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located
on the bottom of the Memory Stick/PRO card is not in the
locked position.

Can not write to the media card.
Cause

Solution

The media card is a read-only memory (ROM) card.

Check the manufacturer’s documentation included with your
card to see if it writable. Refer to the previous section for a list
of compatible cards.

Media card is locked. Locking the media card is a safety
feature that prevents writing to and deleting from an SD/
Memory Stick/PRO card.

If using an SD card, make sure that the lock tab located on the
right of the SD card is not in the locked position. If using a
Memory Stick/PRO card, make sure that the lock tab located
on the bottom of the Memory Stick/PRO card is not in the
locked position.

Unable to access data on the media card after inserting it into a slot.
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Cause

Solution

The media card is not inserted properly, is inserted in the
wrong slot, or is not supported.

Ensure that the card is inserted properly with the gold contact
on the correct side. The green LED will light if inserted
properly.
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Do not know how to remove a media card correctly.
Cause

Solution

The computer’s software is used to safely eject the card.

In Windows 7, click Start, select Computer, right-click on
the corresponding drive icon, and then select Eject. Pull the
card out of the slot.
In Windows 8, on the Start screen, type e, and then click File
Explorer from the list of applications. Expand Computer,
right-click on the corresponding drive icon, and then select
Eject. Pull the card out of the slot.
NOTE: Never remove the card when the green LED is
flashing

After installing the media card reader and booting to Windows, the reader and the inserted cards are
not recognized by the computer.
Cause

Solution

The operating system needs time to recognize the device if the
reader was just installed into the computer and you are
turning the PC on for the first time.

Wait a few seconds so that the operating system can
recognize the reader and the available ports, and then
recognize the media inserted in the reader.

After inserting a media card in the reader, the computer attempts to boot from the media card.
Cause

Solution

The inserted media card has boot capability.

1.

If you do not want to boot from the media card, remove
it during boot or do not select the option to boot from the
inserted media card during the boot process.

2.

During POST (Power On Self-Test), press F9 to modify the
boot menu.

3.

Change the boot sequence in F10 Computer Setup.
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Solving Display Problems
If you encounter display problems, see the documentation that came with the monitor and to the
common causes and solutions listed in the following table.
Table 8-5 Solving Display Problems
Blank screen (no video).
Cause

Solution

Monitor is not turned on and the monitor light is not on.

Turn on the monitor and check that the monitor light is on.

Bad monitor.

Try a different monitor.

The cable connections are not correct.

Check the cable connection from the monitor to the computer
and to the electrical outlet.

You may have a screen blanking utility installed or energy
saver features are enabled.

Press any key or click the mouse button and type your
password (if set).

System ROM is corrupted; system is running in Boot Block
Emergency Recovery Mode (indicated by eight beeps).

Reflash the system ROM with the latest BIOS image.

You are using a fixed-sync monitor and it will not sync at the
resolution chosen.

Be sure that the monitor can accept the same horizontal scan
rate as the resolution chosen.

Computer is in Sleep state.

Press the power button to resume from Sleep state.
CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Monitor cable is plugged into the wrong connector.

Systems may have a monitor connection on both the
motherboard or an add-in card. Try moving the monitor
connection to a different connector on the back of the
computer

Monitor settings in the computer are not compatible with the
monitor.

1.

In Control Panel, select Category from the View by
list, then under Appearance and Personalization,
select Adjust screen resolution.
To access Control Panel in Windows 7, click Start, and
then select Control Panel.
To access Control Panel in Windows 8, from the Start
screen, type c, and then select Control Panel from the
list of applications.

2.
Monitor is configured to use an input that is not active.
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Expand the Resolution box, and then use the sliding
control to reset the resolution.

Use the monitor's on-screen menu controls to select the input
that is being driven by the system. Refer to the monitor's user
documentation for more information on the on-screen controls
and settings.

Blank screen and the power LED flashes Red five times, once every second, followed by a two second
pause, and the computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Pre-video memory error.

1.

Reseat DIMMs. Power on the system.

2.

Replace DIMMs one at a time to isolate the faulty
module.

3.

Replace third-party memory with HP memory.

4.

Replace the system board.

Blank screen and the power LED flashes Red six times, once every second, followed by a two second
pause, and the computer beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Pre-video graphics error.

For systems with a graphics card:
1.

Reseat the graphics card (if applicable). Power on the
system.

2.

Replace the graphics card (if applicable).

3.

Replace the system board.

For systems with integrated graphics, replace the system
board.

Blank screen and the power LED flashes Red seven times, once every second, followed by a two second
pause, and the computer beeps seven times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

System board failure (ROM detected failure prior to video).

Replace the system board.

Monitor does not function properly when used with energy saver features.
Cause

Solution

Monitor without energy saver capabilities is being used with
energy saver features enabled.

Disable monitor energy saver feature.
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Dim characters.
Cause

Solution

The brightness and contrast controls are not set properly.

Adjust the monitor brightness and contrast controls.

Cables are not properly connected.

Check that the graphics cable is securely connected to the
graphics card (if applicable) or video connector and the
monitor.

Blurry video or requested resolution cannot be set.
Cause

Solution

If the graphics controller was upgraded, the correct graphics
drivers may not be loaded.

Install the video drivers included in the upgrade kit.

Monitor is not capable of displaying requested resolution.

Change requested resolution.

Graphics card is bad.

Replace the graphics card.

The picture is broken up, rolls, jitters, or flashes.
Cause

Solution

The monitor connections may be incomplete or the monitor
may be incorrectly adjusted.

1.

Be sure the monitor cable is securely connected to the
computer.

2.

In a two-monitor system or if another monitor is in close
proximity, be sure the monitors are not interfering with
each other’s electromagnetic field by moving them apart.

3.

Fluorescent lights or fans may be too close to the
monitor.

Monitor needs to be degaussed.

Degauss the monitor. Refer to the documentation that came
with the monitor for instructions.

Image is not centered.
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Cause

Solution

Position may need adjustment.

Press the monitor's Menu button to access the OSD menu.
Select ImageControl/ Horizontal Position or Vertical
Position to adjust the horizontal or vertical position of the
image.
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“No Connection, Check Signal Cable” displays on screen.
Cause

Solution

Monitor video cable is disconnected.

Connect the video cable between the monitor and computer.
CAUTION: Ensure that the computer power is off while
connecting the video cable.

“Out of Range” displays on screen.
Cause

Solution

Video resolution and refresh rate are set higher than what the
monitor supports.

Restart the computer and enter Safe Mode. Change the
settings to a supported setting then restart the computer so that
the new settings take effect.
To enter Safe Mode in Windows 7:
1.

Restart the computer.

2.

Press and hold the F8 key as your computer restarts,
before the Windows logo appears. If the Windows logo
appears, you must restart the computer and try again.

3.

On the Advanced Boot Options screen, use the arrow
keys to highlight the safe mode option you want, and
then press Enter.

4.

Log on to your computer with a user account that has
administrator rights.
When your computer is in safe mode, Safe Mode
displays in the corners of your monitor. To exit safe
mode, restart your computer and let Windows start
normally.

To enter Safe Mode in Windows 8:
1.

Press the Windows logo + l to open the Settings charm.

2.

Select Change PC Settings, select General, and then
under Advanced startup, click Restart now.

3.

Select Troubleshoot, select Advanced options,
select Startup Settings, and then click Restart.

4.

Use the function keys or number keys to select the safe
mode option you want.
When your computer is in safe mode, Safe Mode
displays in the corners of your monitor. To exit safe
mode, restart your computer and let Windows start
normally.
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High pitched noise coming from inside a flat panel monitor.
Cause

Solution

Brightness and/or contrast settings are too high.

Lower brightness and/or contrast settings.

Fuzzy focus; streaking, ghosting, or shadowing effects; horizontal scrolling lines; faint vertical bars; or
unable to center the picture on the screen (flat panel monitors using an analog VGA input connection
only).
Cause

Solution

Flat panel monitor’s internal digital conversion circuits may be
unable to correctly interpret the output synchronization of the
graphics card.

1.

Select the monitor’s Auto-Adjustment option in the
monitor’s on-screen display menu.

2.

Manually synchronize the Clock and Clock Phase onscreen display functions. To download a SoftPaq that will
assist you with the synchronization, go to the following
Web site, select the appropriate monitor, and download
either SP32347 or SP32202: http://www.hp.com/
support

Graphics card is not seated properly or is bad (some models).

1.

Reseat the graphics card.

2.

Replace the graphics card.

Certain typed symbols do not appear correct.
Cause

Solution

The font you are using does not support that particular
symbol.

Use the Character Map to locate and select the appropriate
symbol. You can copy the symbol from the Character Map
into a document.
In Windows 7, click Start, select All Programs, select
Accessories, select System Tools, and then select
Character Map.
In Windows 8, on the Start screen, type ch, and then select
Character Map from the list of applications.

98

Chapter 8 Troubleshooting Without Diagnostics

Solving Audio Problems
If the computer has audio features and you encounter audio problems, see the common causes and
solutions listed in the following table.
Table 8-6 Solving Audio Problems
Sound cuts in and out.
Cause

Solution

Processor resources are being used by other open
applications.

Shut down all open processor-intensive applications.

Sound does not come out of the speaker or headphones.
Cause

Solution

Software volume control is turned down or muted.

Double-click the Speaker icon on the taskbar, then make
sure that Mute is not selected and use the volume slider to
adjust the volume.
NOTE: In Windows 8, the taskbar is available at the bottom
of the Desktop screen.

Audio is hidden in Computer Setup.

Enable the audio in Computer Setup: Security >
Device Security > System Audio.

The external speakers are not turned on.

Turn on the external speakers.

The audio device may be connected to the wrong jack.

Ensure that the device is connected to the correct jack on the
computer. The rear audio jack output is the green receptacle.
The speakers should be plugged into the line-out jack and the
headphones should be plugged into the headphone jack.

External speakers plugged into the wrong audio jack on a
recently installed sound card.

See the sound card documentation for proper speaker
connection. The rear audio jack output is the green
receptacle.

Headphones or devices connected to the line-out connector
mute the internal speaker.

Turn on and use headphones or external speakers, if
connected, or disconnect headphones or external speakers.

Computer is in Sleep state.

Press the power button to resume from Sleep state.
CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Internal speaker is disabled in Computer Setup.

Enable the internal speaker in Computer Setup. Select
Advanced > Device Options > Internal Speaker.
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Table 8-6 Solving Audio Problems (continued)
Sound does not come out of the speaker or headphones.
Cause

Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be
listed in Device Manager. Make sure the correct device is
being used.
To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.
To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Sound from headphones is not clear or muffled.
Cause

Solution

Headphones are plugged into the rear audio output
connector. The rear audio output connector is for powered
audio devices and is not designed for headphone use.

Plug the headphones into the headphone connector on the
front of the computer.

Computer appears to be locked up while recording audio.
Cause

Solution

The hard disk may be full.

Before recording, make sure there is enough free space on the
hard disk. You can also try recording the audio file in a
compressed format.

Line-in jack is not functioning properly.
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Cause

Solution

Jack has been reconfigured in the audio driver or application
software.

In the audio driver or application software, reconfigure the
jack or set the jack to its default value.
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There is no sound or sound volume is too low.
Cause

Solution

The application is set to use a different audio device than
speakers.

Some graphics cards support audio over the DisplayPort
connection (if applicable), so multiple audio devices may be
listed in Device Manager. Make sure the correct device is
being used.
To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.
To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Some applications can select which audio output device is
used.

Make sure the application has selected the correct audio
device.

The operating system controls may be set to use a different
audio device as the default output device than what is
expected.

Set the operating system to use the correct audio device.

Solving Printer Problems
If you encounter printer problems, see the documentation that came with the printer and to the common
causes and solutions listed in the following table.
Table 8-7 Solving Printer Problems
Printer will not print.
Cause

Solution

Printer is not turned on and online.

Turn the printer on and make sure it is online.

The correct printer drivers for the application are not installed.

1.

Install the correct printer driver for the application.

2.

Try printing using the MS-DOS command:

DIR C:\ > [printer port]
where [printer port] is the address of the printer being
used. If the printer works, reload the printer driver.
To run MS-DOS commands, press the Windows key + r, type
cmd in the Open box, and then click OK.
If you are on a network, you may not have made the
connection to the printer.

Make the proper network connections to the printer.

Printer may have failed.

Run printer self-test.
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Printer will not turn on.
Cause

Solution

The cables may not be connected properly.

Reconnect all cables and check the power cord and electrical
outlet.

Printer prints garbled information.
Cause

Solution

The correct printer driver for the application is not installed.

Install the correct printer driver for the application.

The cables may not be connected properly.

Reconnect all cables.

Printer memory may be overloaded.

Reset the printer by turning it off for one minute, then turn it
back on.

Printer will not print.
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Cause

Solution

The printer may be out of paper.

Check the paper tray and refill it if it is empty.
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Solving Keyboard and Mouse Problems
If you encounter keyboard or mouse problems, see the documentation that came with the equipment
and to the common causes and solutions listed in the following table.
Table 8-8 Solving Keyboard Problems
A wireless keyboard/mouse is not working correctly. Symptoms include lagging mouse movement,
jumpy mouse/keyboard, or no function of mouse/keyboard and external drive.
Cause

Solution

If your computer is equipped with USB 3.0 ports, connected
USB 3.0 devices can interfere with the wireless keyboard USB
receiver.

Connect the wireless keyboard USB receiver to a USB 2.0
port that is separated from ports with USB 3.0 devices. If you
still experience interference, you may have to place the
connectors farther apart using an external USB hub.

Keyboard commands and typing are not recognized by the computer.
Cause

Solution

Keyboard connector is not properly connected.

Shut down the computer, reconnect the keyboard to the back
of the computer, and then restart the computer.

Program in use has stopped responding to commands.

Shut down your computer using the mouse and then restart the
computer.

Keyboard needs repairs.

See the Worldwide Limited Warranty for terms and
conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.
CAUTION: When attempting to resume from Sleep date, do
not hold down the power button for more than four seconds.
Otherwise, the computer will shut down and you will lose any
unsaved data.

Cursor will not move using the arrow keys on the keypad.
Cause

Solution

The Num Lock key is on.

Press the Num Lock key. The Num Lock light should be off if
you want to use the arrow keys on the keypad. You can
disable or enable the Num Lock key in Computer Setup at
Advanced > Device Options.
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Table 8-9 Solving Mouse Problems
Mouse does not respond to movement or is too slow.
Cause

Solution

Mouse connector is not properly plugged into the back of the
computer.

Shut down the computer using the keyboard.
Windows 7:
1.

Press the Ctrl and Esc keys at the same time (or press the
Windows logo key) to display the Start menu.

2.

Use the arrow keys to select Shut Down and then press
Enter.

3.

After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Windows 8:
1.

Press the Windows logo + l to open the Settings charm.

2.

Use the arrow keys to select Power, and then press
Enter.

3.

Use the arrow keys to select Shut Down, and then
press Enter.

4.

After the shutdown is complete, plug the mouse
connector into the back of the computer (or the
keyboard) and restart.

Program in use has stopped responding to commands.

Shut down the computer using the keyboard then restart the
computer.

Mouse may need cleaning.

Remove the roller ball cover on the mouse and clean the
internal components.

Mouse may need repair.

See the Worldwide Limited Warranty for terms and
conditions.

Computer is in Sleep state.

Press the power button to resume from Sleep state.
CAUTION: When attempting to resume from Sleep state,
do not hold down the power button for more than four
seconds. Otherwise, the computer will shut down and you will
lose any unsaved data.

Mouse will only move vertically, horizontally, or movement is jerky.
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Cause

Solution

Mouse roller ball or the rotating encoder shafts that make
contact with the ball are dirty.

Remove roller ball cover from the bottom of the mouse and
clean the internal components with a mouse cleaning kit
available from most computer stores.
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Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove hardware, such as an additional
drive or expansion card. If you install a plug and play device, Windows automatically recognizes the
device and configures the computer. If you install a non-plug and play device, you must reconfigure the
computer after completing installation of the new hardware. In Windows, use the Add Hardware
Wizard and follow the instructions that appear on the screen.
To open the Add Hardware Wizard, open a Command Prompt and open hdwwiz.exe.
WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.
Table 8-10 Solving Hardware Installation Problems
A new device is not recognized as part of the system.
Cause

Solution

Device is not seated or connected properly.

Ensure that the device is properly and securely connected and
that pins in the connector are not bent down.

Cable(s) of new external device are loose or power cables
are unplugged.

Ensure that all cables are properly and securely connected
and that pins in the cable or connector are not bent down.

Power switch of new external device is not turned on.

Turn off the computer, turn on the external device, then turn on
the computer to integrate the device with the computer system.

When the system advised you of changes to the configuration,
you did not accept them.

Reboot the computer and follow the instructions for accepting
the changes.

A plug and play board may not automatically configure when
added if the default configuration conflicts with other devices.

Use Windows Device Manager to deselect the automatic
settings for the board and choose a basic configuration that
does not cause a resource conflict. You can also use
Computer Setup to reconfigure or disable devices to resolve
the resource conflict.
To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.
To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that Device
available is selected for appropriate USB ports under
Security > USB Security.
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Computer will not start.
Cause

Solution

Wrong memory modules were used in the upgrade or
memory modules were installed in the wrong location.

1.

Review the documentation that came with the system to
determine if you are using the correct memory modules
and to verify the proper installation.
NOTE: DIMM1 or XMM1 must always be installed. On
all computers except the USDT, DIMM1 must be installed
before DIMM2, and DIMM3 must be installed before
DIMM4.

2.

Observe the beeps and LED lights on the front of the
computer. Beeps and flashing LEDs are codes for specific
problems.

3.

If you still cannot resolve the issue, contact Customer
Support.

Power LED flashes Red five times, once every second, followed by a two second pause, and the
computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Memory is installed incorrectly or is bad.

CAUTION: To avoid damage to the DIMMs or the system
board, you must unplug the computer power cord before
attempting to reseat, install, or remove a DIMM module.
1.

Reseat DIMMs. Power on the system.

2.

Replace DIMMs one at a time to isolate the faulty
module.
NOTE: DIMM1 or XMM1 must always be installed. On
all computers except the USDT, DIMM1 must be installed
before DIMM2, and DIMM3 must be installed before
DIMM4
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3.

Replace third-party memory with HP memory.

4.

Replace the system board.

Power LED flashes Red six times, once every second, followed by a two second pause, and the computer
beeps six times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Graphics card (some models) is not seated properly or is bad,
or system board is bad.

For systems with a graphics card:
1.

Reseat the graphics card. Power on the system.

2.

Replace the graphics card.

3.

Replace the system board.

For systems with integrated graphics, replace the system
board.

Power LED flashes Red ten times, once every second, followed by a two second pause, and the computer
beeps ten times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Bad option card.

1.

Check each option card by removing the cards one at
time (if multiple cards), then power on the system to see if
fault goes away.

2.

Once bad card is identified, remove and replace bad
option card.

3.

Replace the system board.

Solving Network Problems
Some common causes and solutions for network problems are listed in the following table. These
guidelines do not discuss the process of debugging the network cabling.
Table 8-11 Solving Network Problems
Wake-on-LAN feature is not functioning.
Cause

Solution

S5 Maximum Power Saving feature is enabled.

Disable the S5 Maximum Power Saving option in Computer
Setup. Select Power > Hardware Power Management
> S5 Maximum Power Savings.
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Table 8-11 Solving Network Problems (continued)
Wake-on-LAN feature is not functioning.
Cause

Solution

S5 Wake on LAN is disabled (some models).

Enable the S5 Wake on LAN option in Computer Setup.
Select Advanced > Device Options > S5 Wake on
LAN.

Wake-on-LAN is not enabled.

To enable Wake-on-LAN in Windows 7:
1.

Select Start > Control Panel > Network and
Sharing Center.

2.

Under Tasks, select Manage network
connections.

3.

Click Local Area Connection.

4.

Click the Properties button.

5.

Click the Configure button.

6.

Click the Power Management tab, then select
Allow this device to wake the computer.

To enable Wake-on-LAN in Windows 8:
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1.

From the Start screen, type c, and then select Control
Panel from the list of applications.

2.

Select Network and Sharing Center, and then click
the Ethernet link next to the connection.

3.

Click the Properties button.

4.

Click the Configure button.

5.

Click the Power Management tab, then enable the
appropriate Wake-on LAN option.

Network driver does not detect network controller.
Cause

Solution

Network controller is disabled.

1.

Run Computer Setup and enable network controller.

2.

Enable the network controller in the operating system
using Device Manager.
To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.
To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Incorrect network driver.

Check the network controller documentation for the correct
driver or obtain the latest driver from the manufacturer’s Web
site.

Network status link light never flashes.
NOTE:

The network status light is supposed to flash when there is network activity.

Cause

Solution

No active network is detected.

Check cabling and network equipment for proper connection.

Network controller is not set up properly.

Check for the device status within Windows, such as Device
Manager for driver load and the Network Connections applet
within Windows for link status.
To access Device Manager in Windows 7, click Start, select
Control Panel, and then select Device Manager.
To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Network controller is disabled.

1.

Run Computer Setup and enable network controller.

2.

Enable the network controller in the operating system
using Device Manager.
To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.
To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

Network driver is not properly loaded.

Reinstall network drivers.

System cannot autosense the network.

Disable auto-sensing capabilities and force the system into the
correct operating mode.
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Diagnostics reports a failure.
Cause

Solution

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The cable is attached to the incorrect connector.

Ensure that the cable is attached to the correct connector.

There is a problem with the cable or a device at the other end
of the cable.

Ensure that the cable and device at the other end are
operating correctly.

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller is defective.

Contact an authorized service provider.

Diagnostics passes, but the computer does not communicate with the network.
Cause

Solution

Network drivers are not loaded, or driver parameters do not
match current configuration.

Make sure the network drivers are loaded and that the driver
parameters match the configuration of the network controller.
Make sure the correct network client and protocol is installed.

The network controller is not configured for this computer.

Select the Network and Sharing Center icon in the
Control Panel and configure the network controller.
To access Control Panel in Windows 7, click Start, and then
select Control Panel.
To access Control Panel in Windows 8, from the Start screen,
type c, and then select Control Panel.

Network controller stopped working when an expansion board was added to the computer.
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Cause

Solution

Network controller interrupt is shared with an expansion
board.

Under the Computer Setup Advanced menu, change the
resource settings for the board.

The network controller requires drivers.

Verify that the drivers were not accidentally deleted when the
drivers for a new expansion board were installed.

The expansion board installed is a network card (NIC) and
conflicts with the embedded NIC.

Under the Computer Setup Advanced menu, change the
resource settings for the board.
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Network controller stops working without apparent cause.
Cause

Solution

The files containing the network drivers are corrupted.

Reinstall the network drivers using the Recovery Disc Set in
Windows 7 or Windows recovery tools in Windows 8.
If necessary, download the softpaq from the web (from a
different computer).

The cable is not securely connected.

Ensure that the cable is securely attached to the network
connector and that the other end of the cable is securely
attached to the correct device.

The network controller is defective.

Contact an authorized service provider.

New network card will not boot.
Cause

Solution

New network card may be defective or may not meet industrystandard specifications.

Install a working, industry-standard NIC, or change the boot
sequence to boot from another source.

Cannot connect to network server when attempting Remote System Installation.
Cause

Solution

The network controller is not configured properly.

Verify Network Connectivity, that a DHCP Server is present,
and that the Remote System Installation Server contains the
NIC drivers for your NIC.

System setup utility reports unprogrammed EEPROM.
Cause

Solution

Unprogrammed EEPROM.

Contact an authorized service provider.

Solving Memory Problems
If you encounter memory problems, some common causes and solutions are listed in the following
table.
CAUTION: Power may still be supplied to the DIMMs when the computer is turned off (depending on
the Management Engine (ME) settings). To avoid damage to the DIMMs or the system board, you must
unplug the computer power cord before attempting to reseat, install, or remove a memory module.
For those systems that support ECC memory, HP does not support mixing ECC and non-ECC memory.
Otherwise, the computer will not boot the operating system.
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NOTE: The memory count will be affected by configurations with the Management Engine (ME)
enabled. The ME uses 8MB of system memory in single channel mode or 16MB of memory in dualchannel mode to download, decompress, and execute the ME firmware for Out-of-Band (OOB), thirdparty data storage, and other management functions.
Table 8-12 Solving Memory Problems
System will not boot or does not function properly after installing additional memory modules.
Cause

Solution

A memory module is not installed in the DIMM1 or XMM1
socket.

Ensure that a memory module is installed in the DIMM1 or
XMM1 socket on the system board. This socket must be
populated with a memory module.

Memory module is not the correct type or speed grade for the
system or the new memory module is not seated properly.

Replace module with the correct industry-standard device for
the computer. On some models, ECC and non-ECC memory
modules cannot be mixed.

Out of memory error.
Cause

Solution

You have run out of memory to run the application.

Check the application documentation to determine the
memory requirements.

Memory count during POST is wrong.
Cause

Solution

The memory modules may not be installed correctly.

Check that the memory modules have been installed correctly
and that proper modules are used.

Integrated graphics may use system memory.

No action required.

Insufficient memory error during operation.
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Cause

Solution

Too many Terminate and Stay Resident programs (TSRs) are
installed.

Delete any TSRs that you do not need.

You have run out of memory for the application.

Check the memory requirements for the application or add
more memory to the computer.
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Power LED flashes Red five times, once every second, followed by a two second pause, and the
computer beeps five times. (Beeps stop after fifth iteration but LEDs continue flashing.)
Cause

Solution

Memory is installed incorrectly or is bad.

1.

Reseat DIMMs. Power on the system.

2.

Replace DIMMs one at a time to isolate the faulty
module.

3.

Replace third-party memory with HP memory.

4.

Replace the system board.

Solving Processor Problems
If you encounter processor problems, common causes and solutions are listed in the following table.
Table 8-13 Solving Processor Problems
Poor performance is experienced.
Cause

Solution

Processor is hot.

1.

Make sure the airflow to the computer is not blocked.

2.

Make sure the fans are connected and working properly
(some fans only operate when needed).

3.

Make sure the processor heat sink is installed properly.

Power LED flashes Red three times, once every second, followed by a two second pause.
Cause

Solution

Processor is not seated properly or not installed.

1.

Check to see that the processor is present.

2.

Reseat the processor.

Power LED flashes Red eleven times, once every second, followed by a two second pause.
Cause

Solution

The current processor does not support a feature previously
enabled on this system.

1.

Install a TXT (Trusted Execution Technology) capable
processor.

2.

Disable TXT in the Computer Setup (F10) utility.

3.

Reinstall the original processor.
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Solving CD-ROM and DVD Problems
If you encounter CD-ROM or DVD problems, see the common causes and solutions listed in the
following table or to the documentation that came with the optional device.
Table 8-14 Solving CD-ROM and DVD Problems
System will not boot from CD-ROM or DVD drive.
Cause

Solution

The device is attached to a SATA port that has been hidden in
the Computer Setup utility.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
CD-ROM is enabled in Storage > Boot Order.

Network Boot is enabled in Computer Setup.

Run the Computer Setup utility and disable Network Boot in
Security > Network Boot.

Non-bootable CD in drive.

Try a bootable CD in the drive.

Boot order not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Drive not found (identified).
Cause

Solution

Cable could be loose.

Check cable connections.

The system may not have automatically recognized a newly
installed device.

See reconfiguration directions in the Solving Hardware
Installation Problems on page 105 section. If the system still
does not recognize the new device, check to see if the device
is listed within Computer Setup. If it is listed, the probable
cause is a driver problem. If it is not listed, the probable cause
is a hardware problem.
If this is a newly installed drive, run the Computer Setup utility
and try adding a POST delay under Advanced > PowerOn Options.
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The device is attached to a SATA port that has been hidden in
Computer Setup.

Run the Computer Setup utility and ensure Device Available
is selected for the device's SATA port in Security > Device
Security.

Drive responds slowly immediately after power-up.

Run Computer Setup and increase the POST Delay in
Advanced > Power-On Options.
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CD-ROM or DVD devices are not detected or driver is not loaded.
Cause

Solution

Drive is not connected properly or not properly configured.

See the documentation that came with the optional device.

Movie will not play in the DVD drive.
Cause

Solution

Movie may be regionalized for a different country.

See the documentation that came with the DVD drive.

Decoder software is not installed.

Install decoder software.

Damaged media.

Replace media.

Movie rating locked out by parental lock.

Use DVD software to remove parental lock.

Media installed upside down.

Reinstall media.

Cannot eject compact disc (tray-load unit).
Cause

Solution

Disc not properly seated in the drive.

Turn off the computer and insert a thin metal rod into the
emergency eject hole and push firmly. Slowly pull the tray out
from the drive until the tray is fully extended, then remove
the disc.

CD-ROM, CD-RW, DVD-ROM, or DVD-R/RW drive cannot read a disc or takes too long to start.
Cause

Solution

Media is corrupt.

Try different media to confirm whether media is valid.

Media has been inserted upside down.

Re-insert the media with the label facing up.

The DVD-ROM drive takes longer to start because it has to
determine the type of media played, such as audio or video.

Wait at least 30 seconds to let the DVD-ROM drive determine
the type of media being played. If the disc still does not start,
read the other solutions listed for this topic.

CD or DVD disc is dirty.

Clean CD or DVD with a CD cleaning kit, available from most
computer stores.

Windows does not detect the CD-ROM or DVD-ROM drive.

1.

Use Device Manager to remove or uninstall the device.
To access Device Manager in Windows 7, click Start,
select Control Panel, and then select Device
Manager.
To access Device Manager in Windows 8, from the Start
screen, type c, select Control Panel from the list of
applications, and then select Device Manager.

2.

Restart the computer and let Windows detect the CD or
DVD driver.
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Recording or copying CDs is difficult or impossible.
Cause

Solution

Wrong or poor quality media type.

1.

Try using a slower speed when recording.

2.

Verify that you are using the correct media for the drive.

3.

Try a different brand of media. Quality varies widely
between manufacturers.

Solving USB Flash Drive Problems
If you encounter USB flash drive problems, common causes and solutions are listed in the following
table.
Table 8-15 Solving USB Flash Drive Problems
USB flash drive is not seen as a drive letter in Windows.
Cause

Solution

The drive letter after the last physical drive is not available.

Change the default drive letter for the flash drive in Windows.

USB flash drive not found (identified).
Cause

Solution

The device is attached to a USB port that has been hidden in
Computer Setup.

Run the Computer Setup utility and enable USB ports in
Security > USB Security.

The device was not properly seated before power-up.

Ensure the device is fully inserted into the USB port before
applying power to the system

System will not boot from USB flash drive.

116

Cause

Solution

Boot order is not correct.

Run the Computer Setup utility and change boot sequence in
Storage > Boot Order.

Removable Media Boot is disabled in the Computer Setup
utility.

Run the Computer Setup utility and enable booting to
removable media in Storage > Storage Options. Ensure
USB is enabled in Storage > Boot Order.

Chapter 8 Troubleshooting Without Diagnostics

The computer boots to DOS after making a bootable flash drive.
Cause

Solution

Flash drive is bootable.

Install the flash drive only after the operating system boots.

Flash drive is defective.

Try a different flash drive.

Solving Front Panel Component Problems
If you encounter problems with devices connected to the front panel, refer to the common causes and
solutions listed in the following table.
A USB device, headphone, or microphone is not recognized by the computer.
Cause

Solution

Device is not properly connected.

1.

Turn off the computer.

2.

Reconnect the device to the front of the computer and
restart the computer.

The device does not have power.

If the USB device requires AC power, be sure one end is
connected to the device and one end is connected to a live
outlet.

The correct device driver is not installed.

1.

Install the correct driver for the device.

2.

You might need to reboot the computer.

1.

If possible, replace the cable.

2.

Restart the computer.

1.

Replace the device.

2.

Restart the computer.

The cable from the device to the computer does not work.

The device is not working.

USB ports on the computer are disabled in Computer Setup.

Run the Computer Setup utility and ensure that the USB ports
are set to Enabled in Security > USB Security.
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Solving Internet Access Problems
If you encounter Internet access problems, consult your Internet Service Provider (ISP) or refer to the
common causes and solutions listed in the following table.
Unable to connect to the Internet.
Cause

Solution

Internet Service Provider (ISP) account is not set up properly.

Verify Internet settings or contact your ISP for assistance.

Web browser is not set up properly.

Verify that the Web browser is installed and set up to work
with your ISP.

Cable/DSL modem is not plugged in.

Plug in cable/DSL modem. You should see a “power” LED
light on the front of the cable/DSL modem.

Cable/DSL service is not available or has been interrupted
due to bad weather.

Try connecting to the Internet at a later time or contact your
ISP. (If the cable/DSL service is connected, the “cable” LED
light on the front of the cable/DSL modem will be on.)

The CAT5 UTP cable is disconnected.

Connect the CAT5 UTP cable between the cable modem and
the computers’s RJ-45 connector. (If the connection is good,
the “PC” LED light on the front of the cable/DSL modem will
be on.)

IP address is not configured properly.

Contact your ISP for the correct IP address.

Cookies are corrupted. (A “cookie” is a small piece of
information that a Web server can store temporarily with the
Web browser. This is useful for having the browser remember
some specific information that the Web server can later
retrieve.)

Windows 7:
1.

Select Start > Control Panel.

2.

Click Internet Options.

3.

In the Browsing history section on the General tab,
click the Delete button.

4.

Select the Cookies check box and click the Delete
button.

Windows 8:
1.

From the Start screen, type c, and then select Control
Panel from the list of applications..

2.

Click Internet Options.

3.

In the Browsing history section on the General tab,
click the Delete button.

4.

Select the Cookies check box and click the Delete
button.

Cannot automatically launch Internet programs.
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Cause

Solution

You must log on to your ISP before some programs will start.

Log on to your ISP and launch the desired program.
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Solving Software Problems
Most software problems occur as a result of the following:
●

The application was not installed or configured correctly.

●

There is insufficient memory available to run the application.

●

There is a conflict between applications.

●

Be sure that all the needed device drivers have been installed.

●

If you have installed an operating system other than the factory-installed operating system, check
to be sure it is supported on the system.

If you encounter software problems, see the applicable solutions listed in the following table.
Computer will not continue and the HP logo does not display.
Cause

Solution

ROM issue - POST error has occurred.

Observe the beeps and LED lights on the front of the
computer. See Appendix A, POST Error Messages
on page 131 to determine possible causes.
See the Worldwide Limited Warranty for terms and
conditions.
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Computer will not continue after HP logo screen displays.
Cause

Solution

System files may be damaged.

In Windows 7, use recovery media to scan hard drive for
errors, or use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly. Windows
Startup Repair is one of the recovery tools in the System
Recovery Options menu. You can also create a system repair
disc that contains the System Recovery Options menu. If the
problem is severe enough that Startup Repair doesn't start on
its own and you can't access the System Recovery Options
menu on your computer's hard disk, you can get to the menu
and start Startup Repair by using the Windows installation
disc or a system repair disc that you created earlier.
In Windows 8, use Automatic Repair to fix problems that
might prevent Windows from starting correctly.
To access Automatic Repair:
1.

Press the Windows logo + l to open the Settings charm.

2.

Select Change PC Settings, select General, and then
under Advanced startup, click Restart now.

3.

Select Troubleshoot, select Advanced options, and
then select Automatic Repair.
Windows starts Automatic Repair.

4.

Select the account to use to begin Automatic Repair, and
type the password for the account.
Windows diagnoses the computer and attempts the
repair it.

“Illegal Operation has Occurred” error message is displayed.
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Cause

Solution

Software being used is not Microsoft-certified for your version
of Windows.

Verify that the software is certified by Microsoft for your
version of Windows (see program packaging for this
information).

Configuration files are corrupt.

If possible, save all data, close all programs, and restart the
computer.
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Contacting Customer Support
For help and service, contact an authorized reseller or dealer. To locate a reseller or dealer near you,
visit http://www.hp.com.
NOTE: If you take the computer to an authorized reseller, dealer, or service provider for service,
remember to provide the setup and power-on passwords if they are set.
Refer to the number listed in the warranty or in the Support Telephone Numbers guide for technical
assistance.

Contacting Customer Support
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Restoring and recovering in Windows 7
To protect from loss or damage, back up your personal data files. Refer to the operating system or
backup utility documentation for instructions on making backup copies of your data files.
To protect the software from loss or damage, keep a backup copy of all system software, applications,
and related files stored on the hard drive.
If you cannot create system recovery CDs or DVDs, you can order a recovery disk set from support. To
obtain the support telephone number for your region, see http://www.hp.com/support/contactHP.

System Restore
If you have a problem that might be due to software that you installed on your computer, use System
Restore to return the computer to a previous restore point. You can also set restore points manually.
NOTE: Always use this System Restore procedure before you use the System Recovery feature.
NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.
To start System Restore:
1.

Close all open programs.

2.

Click the Start button, right-click Computer, and then click Properties.

3.

Click System protection, System Restore, click Next, and then follow the on-screen
instructions.

To add restore points manually:
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1.

Close all open programs.

2.

Click the Start button, right-click Computer, click Properties, and then click System
protection.

3.

Under Protection Settings, select the disk for which you want to create a restore point.

4.

Click Create, and then follow the on-screen instructions.
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System Recovery
WARNING! This procedure will delete all user information. To prevent loss of information, be sure to
back up all user information so you can restore it after recovery.
System Recovery completely erases and reformats the hard disk drive, deleting all data files that you
have created, and then reinstalls the operating system, programs, and drivers. However, you must
reinstall any software that was not installed on the computer at the factory. This includes software that
came on media included in the computer accessory box, and any software programs you installed after
purchase.
NOTE: Always use the System Restore procedure before you use the System Recovery program. See
System Restore on page 122.
NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.
You must choose one of the following methods to perform a System Recovery:
●

Recovery image — Run System Recovery from a recovery image stored on your hard disk drive.
The recovery image is a file that contains a copy of the original factory-shipped software. To
perform a System Recovery from a recovery image, see System Recovery when Windows is
responding on page 123 or System Recovery when Windows is not responding on page 124.

●

Recovery media — Run System Recovery from recovery media that you have created from files
stored on your hard disk drive or purchased separately. To create recovery media, see System
recovery using recovery media on page 124.

System Recovery when Windows is responding
CAUTION: System Recovery deletes all data and programs you created or installed. Before you
begin, back up any important data to a CD or DVD or to a USB flash drive.
NOTE: In some cases, you must use recovery media for this procedure. To create this media, follow
the instructions in Creating recovery media on page 125.
If the computer is working and Windows 7 is responding, use these steps to perform a System
Recovery.
1.

Turn off the computer.

2.

Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

3.

Turn on the computer.

4.

When Windows has loaded, click the Start button, click All Programs, click Security and
Protection, click Recovery Manager, and then click Recovery Manager. If prompted,
click Yes to allow the program to continue.

5.

Under I need help immediately, click System Recovery.
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6.

Select Yes, and then click Next. Your computer restarts.
NOTE: If your system does not detect a recovery partition, it prompts you to insert recovery
media that you have created. Insert the first disc or the USB flash drive, select Yes, and then click
Next to restart the computer. If you are using discs, insert the next disc when prompted.

7.

When the computer restarts, you will see the Recovery Manager welcome screen again. Under I
need help immediately, click System Recovery. If you are prompted to back up your files,
and you have not done so, select Back up your files first (recommended), and then click
Next. Otherwise, select Recover without backing up your files, and then click Next.

8.

System Recovery begins. After System Recovery is complete, click Finish to restart the computer.

9.

When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System Recovery when Windows is not responding
CAUTION: System Recovery deletes all data and programs you created or installed.
If Windows is not responding, but the computer is working, follow these steps to perform a System
Recovery.
1.

Turn off the computer. If necessary, press and hold the power button until the computer turns off.

2.

Disconnect all peripheral devices from the computer, except the monitor, keyboard, and mouse.

3.

Press the power button to turn on the computer.

4.

As soon as you see the HP logo screen, repeatedly press the F11 key on your keyboard until the
Windows is Loading Files… message appears on the screen.

5.

Under I need help immediately, click System Recovery.

6.

If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing
up your files, and then click Next.

7.

System Recovery begins. After System Recovery is complete, click Finish to restart the computer.

8.

When Windows has loaded, shut down the computer, reconnect all peripheral devices, and then
turn the computer back on.

System recovery using recovery media
You should create a set of recovery media, either a set of DVDs or a USB flash drive, from the recovery
image stored on your hard disk drive. This image contains the operating system and software program
files that were originally installed on your computer at the factory. You can create only one set of
recovery media for your computer, and the media can be used only with this computer. Store the
recovery media in a safe place.

124

Chapter 9 Backup and Recovery

NOTE: Some features might not be available on systems that are shipped without a Windows
operating system.
●

To create recovery discs, your computer must have a DVD writer, and you must use only highquality blank DVD+R or DVD-R discs.
NOTE: You cannot use DVD+RW, DVD-RW, DVD+RW DL, DVD-RW DL, DVD+R DL, or DVD-R
DL discs to create recovery discs.

●

You have the option of creating a recovery USB flash drive instead, using a high-quality USB
drive.

●

If you are creating recovery discs, be sure to use high-quality discs. It is normal for the system to
reject defective discs. You will be prompted to insert a new blank disc to try again.

●

The number of discs in the recovery-disc set depends on your computer model (typically 3 to 6
DVDs). The Recovery Media Creation program tells you the specific number of blank discs needed
to make the set. If you are using a USB flash drive, the program will tell you the size of the drive
required to store all the data (minimum of 8 GB).
NOTE: The process of creating recovery media is lengthy. You can quit the process at any time.
The next time you initiate the process, it resumes where it left off.

Creating recovery media
To create recovery discs:
1.

Close all open programs.

2.

Click the Start button, click All Programs, click Security and Protection, and then click HP
Recovery Media Creation. If prompted, click Yes to allow the program to continue.

3.

Click Create recovery media using blank DVD(s), and then click Next.

4.

Follow the on-screen instructions. Label each disc as you make it (for example, Recovery 1,
Recovery 2), and then store the discs in a secure place.

To create a recovery USB flash drive:
NOTE: You must use a flash drive with a capacity of at least 8 GB.
1.

Close all open programs.

2.

Insert the USB flash drive into a USB port on the computer.

3.

Click the Start button, click All Programs, click Security and Protection, and then click
Recovery Media Creation.

4.

Click Create recovery media with a USB flash drive, and then click Next.

5.

Select the USB flash drive from the list of media. The program will let you know how much storage
is required to create the recovery drive. If the USB flash drive does not have enough storage
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capacity, it will appear grayed out, and you must replace it with a larger USB flash drive. Click
Next.
NOTE: Recovery Media Creation formats the flash drive, deleting any files on it.
6.

Follow the on-screen instructions. When the process is complete, label the USB flash drive and
store it in a secure place.

NOTE: Do not use media cards for creating recovery media. The system may not be able to boot up
from a media card and you may not be able to run system recovery.
Using recovery media
CAUTION: System Recovery deletes all data and programs you have created or installed. Back up
any important data to a CD or DVD or to a USB flash drive.
To create recovery media, see System recovery using recovery media on page 124.
To perform a System Recovery using recovery media:
1.

If using a set of DVDs, insert the first recovery disc into the DVD drive tray, and close the tray. If
you are using a recovery USB flash drive, insert it into a USB port.

2.

If the computer is not responding, press and hold the power button for approximately 5 seconds or
until the computer turns off.
or
Click the Start button, and then click Shut Down.

3.

Disconnect all peripheral devices from the computer except the monitor, keyboard, and mouse.

4.

Press the power button to turn on the computer.

5.

Press Esc as the computer is powering on to see the startup menu. Use the arrow keys to select the
boot menu and press Enter. Use the arrow keys to select the location where the recovery media is
inserted (USB or DVD). Press Enter to boot from that device.

6.

If Recovery Manager asks if you want to run System Recovery from Media or Hard Drive, select
Media. On the Welcome screen, under I need help immediately, click Factory Reset.

7.

If you are prompted to back up your files, and you have not done so, select Back up your files
first (recommended), and then click Next. Otherwise, select Recover without backing
up your files, and then click Next.

8.

If you are prompted to insert the next recovery disc, do so.

9.

When Recovery Manager is finished, remove the recovery disc or the recovery USB flash drive
from the system.

10. Click Finish to restart the computer.
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Backup and recovery in Windows 8
To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive, create system repair media, or create system restore points. In case of
system failure, you can use the backup files to restore the contents of your computer.
From the Start screen, type restore, click Settings, and then select from the list of displayed options.
NOTE: For detailed instructions on various backup and restore options, perform a search for these
topics in Help and Support. From the Start screen, type h, and then select Help and Support.
In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.
NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information. From the Start
screen, type h, and then select Help and Support.

Backing up your information
Recovery after a system failure is as good as your most recent backup. You should create system repair
media and your initial backup immediately after initial system setup. As you add new software and
data files, you should continue to back up your system on a regular basis to maintain a reasonably
current backup. The system repair media is used to start up (boot) the computer and repair the
operating system in case of system instability or failure. Your initial and subsequent backups allow you
to restore your data and settings if a failure occurs.
Type backup on the Start screen, click Settings, and then select Save backup copies of your
files with File History.
You can back up your information to an optional external hard drive, or a network drive.
Note the following when backing up:
●

Store personal files in the Documents library, and back it up regularly.

●

Back up templates that are stored in their associated programs.

●

Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a backup using Backup and Restore:
NOTE: Be sure that the computer is connected to AC power before you start the backup process.
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NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.
1.

From the Start screen, type backup, click Settings, and then select from the list of displayed
options.

2.

Follow the on-screen instructions to set up your backup, create a system image, or create system
repair media.

Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:
●

Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Automatic Repair to fix problems that
might prevent Windows from starting correctly.

●

f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair
media you previously created, you must purchase Windows 8 operating system media to reboot the
computer and repair the operating system. For additional information, see Using Windows 8 operating
system media (purchased separately) on page 129.

Using the Windows recovery tools
To recover information you previously backed up:
▲

From the Start screen, type h, and then select Help and Support.

To recover your information using Automatic Repair, follow these steps:
CAUTION: Some Automatic Repair options will completely erase and reformat the hard drive. For
additional information go to Help and Support. From the Start screen, type h, and then select Help
and Support.
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition and the Windows partition:
From the Start screen, type e, and then click Windows Explorer.
– or –
From the Start screen, type c, and then select Computer.
NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 8 operating system media and the Driver
Recovery media (both purchased separately). For additional information, see Using Windows 8
operating system media (purchased separately) on page 129.
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3.

If the Windows partition and the HP Recovery partition are listed, restart the computer after
Windows has loaded, and then press and hold Shift while clicking Restart.
NOTE: If the computer fails to boot to Windows after several attempts, the system will boot to
the Windows Recovery Environment by default.

4.

Select Troubleshoot, select Advanced Options, and then select Automatic Repair.

5.

Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support. From the Start screen, type h, and then select Help and
Support.

Using f11 recovery tools
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
that you have created and any software that you have installed on the computer are permanently
removed. The f11 recovery tool reinstalls the operating system and HP programs and drivers that were
installed at the factory. Software not installed at the factory must be reinstalled.
To recover the original hard drive image using f11:
1.

If possible, back up all personal files.

2.

If possible, check for the presence of the HP Recovery partition: From the Start screen, type C, and
then select Computer.
NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 8 operating system media, and the Driver Recovery media (both
purchased separately). For additional information, see Using Windows 8 operating system media
(purchased separately) on page 129.

3.

If the HP Recovery partition is listed, restart the computer, and then press esc while the company
logo is displayed. The computer Startup Menu displays.

4.

Press f11 to select the System Recovery option.

5.

Follow the on-screen instructions.

Using Windows 8 operating system media (purchased separately)
To order Windows 8 operating system media, go to http://www.hp.com/support, select your country
or region, and follow the on-screen instructions. You can also order the media by calling support.
CAUTION: Using Windows 8 operating system media completely erases hard drive contents and
reformats the hard drive. All files that you have created and any software that you have installed on the
computer are permanently removed. When reformatting is complete, the recovery process helps you
restore the operating system, as well as drivers, software, and utilities.
To initiate recovery using Windows 8 operating system media:

Backup and recovery in Windows 8
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NOTE: This process takes several minutes.
1.

If possible, back up all personal files.

2.

Restart the computer, and then follow the instructions provided with the Windows 8 operating
system media to install the operating system.

3.

When prompted, press any keyboard key.

4.

Follow the on-screen instructions.

After the repair is completed:
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1.

Remove the Windows 8 operating system media, and then insert the Driver Recovery media.

2.

Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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10 POST Error Messages

This appendix lists the error codes, error messages, and the various indicator light and audible
sequences that you may encounter during Power-On Self-Test (POST) or computer restart, the probable
source of the problem, and steps you can take to resolve the error condition.
POST Message Disabled suppresses most system messages during POST, such as memory count and
non-error text messages. If a POST error occurs, the screen will display the error message. To manually
switch to the POST Messages Enabled mode during POST, press any key (except F10, F11, or F12).
The default mode is POST Message Disabled.
The speed at which the computer loads the operating system and the extent to which it is tested are
determined by the POST mode selection.
Full Boot may also be enabled to run every 1 to 30 days on a regularly scheduled basis. To establish
the schedule, reconfigure the computer to the Full Boot Every x Days mode, using Computer Setup.
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POST Numeric Codes and Text Messages
This section covers those POST errors that have numeric codes associated with them. The section also
includes some text messages that may be encountered during POST.
NOTE: The computer will beep once after a POST text message is displayed on the screen.
Table 10-1 Numeric Codes and Text Messages
Control panel message

Description

Recommended action

101-Option ROM Checksum Error

System ROM checksum.

1.

Verify the correct ROM.

2.

Flash the ROM if needed.

3.

Clear CMOS. (See Appendix B,
Password Security and Resetting CMOS
on page 143.)

4.

Replace the system board.

1.

Clear CMOS. (See Appendix B,
Password Security and Resetting CMOS
on page 143.)

2.

Replace the system board.

103-System Board Failure

162-System Options Not Set

DMA or timers.

Configuration incorrect.
RTC (real-time clock) battery may need to
be replaced.

Run Computer Setup and check the
configuration in Advanced > Onboard
Devices.
Reset the date and time under Control
Panel. If the problem persists, replace the
RTC battery. See the Removal and
Replacement section for instructions on
installing a new battery, or contact an
authorized dealer or reseller for RTC battery
replacement.

163-Time & Date Not Set

Invalid time or date in configuration memory.
RTC (real-time clock) battery may need to
be replaced.

Reset the date and time under Control
Panel (Computer Setup can also be used). If
the problem persists, replace the RTC
battery. See the Removal and Replacement
section for instructions on installing a new
battery, or contact an authorized dealer or
reseller for RTC battery replacement.

163-Time & Date Not Set

CMOS jumper may not be properly installed.

Check for proper placement of the CMOS
jumper if applicable.

164-MemorySize Error

Memory amount has changed since the last
boot (memory added or removed).

Press the F1 key to save the memory
changes.
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Table 10-1 Numeric Codes and Text Messages (continued)
Control panel message

Description

Recommended action

164-MemorySize Error

Memory configuration incorrect.

1.

Run Computer Setup or Windows
utilities.

2.

Make sure the memory module(s) are
installed properly.

3.

If third-party memory has been added,
test using HP-only memory.

4.

Verify proper memory module type.

1.

Ensure memory modules are correctly
installed.

2.

Verify proper memory module type.

3.

Remove and replace the identified
faulty memory module(s).

4.

If the error persists after replacing
memory modules, replace the system
board.

A memory module in memory socket
identified in the error message is missing
critical SPD information, or is incompatible
with the chipset.

1.

Verify proper memory module type.

2.

Try another memory socket.

3.

Replace DIMM with a module
conforming to the SPD standard.

214-DIMM Configuration Warning

Populated DIMM Configuration is not
optimized.

Rearrange the DIMMs so that each channel
has the same amount of memory.

219-ECC Memory Module Detected ECC
Modules not supported on this Platform

Recently added memory module(s) support
ECC memory error correction.

1.

If additional memory was recently
added, remove it to see if the problem
remains.

2.

Check product documentation for
memory support information.

1.

Reconnect keyboard with computer
turned off.

2.

Check connector for bent or missing
pins.

3.

Ensure that none of the keys are
depressed.

4.

Replace keyboard.

1.

Reconnect keyboard with computer
turned off.

2.

Replace the system board.

201-Memory Error

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...

301-Keyboard Error

303-Keyboard Controller Error

RAM failure.

Keyboard failure.

I/O board keyboard controller.
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Table 10-1 Numeric Codes and Text Messages (continued)
Control panel message

Description

Recommended action

304-Keyboard or System Unit Error

Keyboard failure.

1.

Reconnect the keyboard with computer
turned off.

2.

Ensure that none of the keys are
depressed.

3.

Replace the keyboard.

4.

Replace the system board.

1.

Reseat the graphics card (if applicable).

2.

Clear CMOS. (See Appendix B,
Password Security and Resetting CMOS
on page 143.)

3.

Verify monitor is attached and turned
on.

4.

Replace the graphics card (if possible).

501-Display Adapter Failure

Graphics display controller.

510-Flash Screen Image Corrupted

Flash Screen image has errors.

Reflash the system ROM with the latest BIOS
image.

511-CPU, CPUA, or CPUB Fan not Detected

CPU fan is not connected or may have
malfunctioned.

1.

Reseat CPU fan.

2.

Reseat fan cable.

3.

Replace CPU fan.

1.

Reseat chassis, rear chassis, or front
chassis fan.

2.

Reseat fan cable.

3.

Replace chassis, rear chassis, or front
chassis fan.

1.

Reseat front chassis fan.

2.

Reseat fan cable.

3.

Replace front chassis fan.

1.

Reseat CPU or chassis fan.

2.

Reseat fan cable.

3.

Replace CPU or chassis fan.

1.

Reseat power supply fan.

2.

Reseat fan cable.

3.

Replace power supply fan.

512-Chassis, Rear Chassis, or Front Chassis
Fan not Detected

513-Front Chassis fan not detected

514-CPU or Chassis Fan not Detected

515-Power Supply fan not detected

Chassis, rear chassis, or front chassis fan is
not connected or may have malfunctioned.

Front chassis fan is not connected or may
have malfunctioned.

CPU or chassis fan is not connected or may
have malfunctioned.

Power supply fan is not connected or may
have malfunctioned.

660-Display cache is detected unreliable

Integrated graphics controller display cache
is not working properly and will be disabled.

Replace system board if minimal graphics
degrading is an issue.

912-Computer Cover Has Been Removed
Since Last System Startup

Computer cover was removed since last
system startup.

No action required.
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Table 10-1 Numeric Codes and Text Messages (continued)
Control panel message

Description

Recommended action

917-Front Audio Not Connected

Front audio connector has been detached or
unseated from motherboard.

Reconnect or replace front audio cable.

918-Front USB Not Connected

Front USB harness has been detached or
unseated from motherboard.

Reconnect or replace front USB harness.

1151-Serial Port A Address Conflict Detected

Both external and internal serial ports are
assigned to COM1.

1.

Clear CMOS. (See Appendix B,
Password Security and Resetting CMOS
on page 143.)

2.

Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1.

Clear CMOS. (See Appendix B,
Password Security and Resetting CMOS
on page 143.)

2.

Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1.

Clear CMOS. (See Appendix B,
Password Security and Resetting CMOS
on page 143.)

2.

Reconfigure card resources and/or run
Computer Setup or Windows utilities.

1.

Determine if hard drive is giving correct
error message. Enter Computer Setup
and run the Drive Protection System test
under F2 Diagnostics..

2.

Apply hard drive firmware patch
if applicable. (Available at
http://www.hp.com/support.)

3.

Back up contents and replace hard
drive.

1152-Serial Port B Address Conflict Detected

1155-Serial Port Address Conflict Detected

1720-SMART Hard Drive Detects Imminent
Failure

Both external and internal serial ports are
assigned to COM2.

Both external and internal serial ports are
assigned to same IRQ.

Hard drive is about to fail. (Some hard
drives have a hard drive firmware patch that
will fix an erroneous error message.)

1796-SATA Cabling Error

One or more SATA devices are improperly
attached. For optimal performance, the
SATA 0 and SATA 1 connectors must be
used before SATA 2.

Ensure SATA connectors are used in
ascending order. For one device, use SATA
0. For two devices, use SATA 0 and SATA
1. For three devices, use SATA 0, SATA 1,
and SATA 2.

1797-SATA Drivelock is not supported in
RAID mode.

Drivelock is enabled on one or more SATA
hard drives, and they cannot be accessed
while the system is configured for RAID
mode.

Either remove the Drivelocked SATA device
or disable the Drivelock feature. To disable
the Drivelock feature, enter Computer Setup,
change Storage > Storage Options >
SATA Emulation to IDE, and select File >
Save Changes and Exit. Reenter
Computer Setup and select Security >
Drivelock Security. For each listed
Drivelock-capable SATA device, ensure
Drivelock is Disabled. Lastly, change
Storage > Storage Options > SATA
Emulation back to RAID and select File >
Save Changes and Exit.
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Table 10-1 Numeric Codes and Text Messages (continued)
Control panel message

Description

Recommended action

1801-Microcode Patch Error

Processor is not supported by ROM BIOS.

1.

Upgrade BIOS to proper version.

2.

Change the processor.

1.

Reboot the computer.

2.

Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.

If the memory configuration was
recently changed, unplug the computer,
restore the original memory
configuration, and reboot the computer.

4.

If the error persists, replace the system
board.

1.

Reboot the computer.

2.

Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.

If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4.

If the error persists, replace the system
board.

1.

Reboot the computer.

2.

Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.

If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4.

If the error persists, replace the system
board.

1.

Reboot the computer.

2.

Unplug the power cord, re-seat the
memory modules, and reboot the
computer.

3.

If the memory configuration was
recently changed, unplug the power
cord, restore the original memory
configuration, and reboot the computer.

4.

If the error persists, replace the system
board.

2200-PMM Allocation Error during MEBx
Download

2201-MEBx Module did not checksum
correctly

2202-PMM Deallocation Error during MEBx
cleanup

2203-Setup error during MEBx execution
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Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

Memory error during POST execution of the
Management Engine (ME) BIOS Extensions
option ROM.

MEBx selection or exit resulted in a setup
failure.
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Table 10-1 Numeric Codes and Text Messages (continued)
Control panel message

Description

Recommended action

2204-Inventory error during MEBx execution

BIOS information passed to the MEBx
resulted in a failure.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version.

3.

If the error still persists, replace the
system board.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version.

3.

If the error still persists, replace the
system board.

2205-Interface error during MEBx execution

MEBx operation experienced a hardware
error during communication with ME.

2211-Memory not configured correctly for
proper MEBx execution.

DIMM1 or XMM1 is not installed.

Make sure there is a memory module in the
black DIMM1 socket and that it is properly
seated.

2212-USB Key Provisioning failure writing to
device

USB device used for USB key provisioning
will not allow BIOS to update provision file
properly.

1.

Try a different USB key device for
provisioning.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

1.

Update to the latest ME firmware
version.

2.

If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.

3.

If the error still persists, replace the
system board.

1.

Recreate the provisioning file using third
party management console software.

2.

If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.
Otherwise, update the ME firmware
version.

3.

If the error still persists, replace the
system board.

2217-ME Firmware Version request failure

2218-ME Firmware Version should be
updated

2219-USB Key Provisioning file has invalid
header identifier

ME firmware is not properly responding to
BIOS query for version information.

ME firmware must be updated to match
current functionality contained in the system
BIOS.

Provisioning file contained on the USB key
has been corrupted or is not a valid version
for the current ME firmware.
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Table 10-1 Numeric Codes and Text Messages (continued)
Control panel message

Description

Recommended action

2220-USB Key Provisioning file has
mismatch version

Provisioning file contained on the USB key is
not a valid version for the current ME
firmware.

1.

Reboot the computer.

2.

If the error persists and system BIOS
has been recently updated, restore
previous system BIOS version.
Otherwise, update the ME firmware
version.

3.

If the error still persists, replace the
system board.

Error occurred during MEBx execution which
fails into the “General” grouping. Status
information displayed along with the error
provides further clarity into the failure. MEBx
handles transference of information between
the system BIOS and ME firmware.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

Error occurred during MEBx execution which
fails into “ME” grouping.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

Special system configurations with reduced
ME firmware image require BIOS control of
ME firmware upgrading. A failure has
occurred after the ME firmware update
process in which the BIOS could not relock
the ME firmware region.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

Special system configurations with reduced
ME firmware image require BIOS control of
ME firmware upgrading. A failure has
occurred prior to the ME firmware update
process in which the BIOS could not unlock
the ME firmware region.

1.

Reboot the computer.

2.

If the error persists, update to the latest
BIOS version and ME firmware version.

3.

If the error still persists, replace the
system board.

2230-General error during MEBx execution

2231-ME error during MEBx execution

2232-AMT error during MEBx execution

2233-HECI error during MEBx execution

2239-ME image lock failure

2240-ME image unlock failure
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Error occurred during MEBx execution which
fails into “AMT” grouping.

Error occurred during MEBx execution which
fails into “MEI or HECI” grouping.
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Table 10-1 Numeric Codes and Text Messages (continued)
Control panel message

Description

Recommended action

Invalid Electronic Serial Number

Electronic serial number is missing.

Enter the correct serial number in Computer
Setup.

Network Server Mode Active and No
Keyboard Attached

Keyboard failure while Network Server
Mode enabled.

1.

Reconnect keyboard with computer
turned off.

2.

Check connector for bent or missing
pins.

3.

Ensure that none of the keys are
depressed.

4.

Replace keyboard.

Parity Check 2

Parity RAM failure.

Run Computer Setup and Diagnostic utilities.
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Interpreting POST diagnostic front panel LEDs
This section covers the front panel LED codes as well as the audible codes that may occur before or
during POST that do not necessarily have an error code or text message associated with them.
WARNING! When the computer is plugged into an AC power source, voltage is always applied to
the system board. To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet and allow the internal system components to cool
before touching.
NOTE: If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs on the front panel of the
computer and refer to the following table to determine the front panel LED codes.
Recommended actions in the following table are listed in the order in which they should be performed.
Not all diagnostic lights and audible codes are available on all models.
Table 10-2 Diagnostic front panel LEDs and audible codes
Activity

Beeps

Possible Cause

Recommended Action

White Power LED On.

None

Computer on.

None

White Power LED flashes every
two seconds.

None

Computer in Suspend to
RAM mode (some models
only) or normal Suspend
mode.

None required. Press any key or move the mouse
to wake the computer.

Red Power LED flashes two
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

2

Processor thermal
protection activated:

1.

Ensure that the computer air vents are not
blocked and the processor cooling fan is
running.

2.

Open hood, press power button, and see if
the processor fan spins. If the processor fan
is not spinning, make sure the fan's cable is
plugged onto the system board header.

3.

If fan is plugged in, but is not spinning, then
replace heat sink/fan assembly.

4.

Contact an authorized reseller or service
provider.

1.

Check to see that the processor is present.

2.

Reseat the processor.

A fan may be blocked or
not turning.
OR
The heat sink/fan
assembly is not properly
attached to the processor.

Red Power LED flashes three
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.
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3

Processor not installed (not
an indicator of bad
processor).

Table 10-2 Diagnostic front panel LEDs and audible codes (continued)
Activity
Red Power LED flashes four
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

Red Power LED flashes five
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

Red Power LED flashes six
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

Beeps
4

5

6

Possible Cause

Recommended Action

Power failure (power
supply is overloaded).

1.

Open the hood and ensure the 4 or 6-wire
power supply cable is seated into the
connector on the system board.

2.

Check if a device is causing the problem by
removing ALL attached devices. Power on
the system. If the system enters the POST,
then power off and replace one device at a
time and repeat this procedure until failure
occurs. Replace the device that is causing
the failure. Continue adding devices one at
a time to ensure all devices are functioning
properly.

3.

Replace the power supply.

4.

Replace the system board.

Pre-video memory error.

Pre-video graphics error.

CAUTION: To avoid damage to the DIMMs or
the system board, you must unplug the computer
power cord before attempting to reseat, install, or
remove a DIMM module.
1.

Reseat DIMMs.

2.

Replace DIMMs one at a time to isolate the
faulty module.

3.

Replace third-party memory with HP
memory.

4.

Replace the system board.

For systems with a graphics card:
1.

Reseat the graphics card.

2.

Replace the graphics card.

3.

Replace the system board.

For systems with integrated graphics, replace the
system board.
Red Power LED flashes seven
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

7

System board failure
(ROM detected failure
prior to video).

Replace the system board.

Red Power LED flashes eight
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

8

Invalid ROM based on
bad checksum.

1.

Reflash the system ROM with the latest BIOS
image. See the “Boot Block Emergency
Recovery Mode” section of the Desktop
Management Guide for more information.

2.

Replace the system board.
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Table 10-2 Diagnostic front panel LEDs and audible codes (continued)
Activity

Beeps

Red Power LED flashes nine
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

9

Red Power LED flashes eleven
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

11

Red Power LED flashes eleven
times, once every second,
followed by a two second
pause. Beeps stop after fifth
iteration but LEDs continue until
problem is solved.

12

System does not power on and
LEDs are not flashing.

None

Possible Cause

Recommended Action

System powers on but is
unable to boot.

1.

Unplug the AC power cord from the
computer, wait 30 seconds, then plug the
power cord back in to the computer.

2.

Replace the system board.

3.

Replace the processor.

1.

Install a TXT capable processor.

2.

Disable TXT in the Computer Setup (F10)
utility.

3.

Reinstall the original processor.

1.

Clean the MXM graphics card heat sink.

2.

Replace the MXM graphics card heat sink.

3.

Replace the MXM graphic card.

The current processor does
not support a feature
previously enabled on this
system.

MXM thermal shutdown.

System unable to power
on.

Press and hold the power button for less than 4
seconds. If the hard drive LED turns white, the
power button is working correctly. Try the
following:
1.

Replace the system board.

OR
Press and hold the power button for less than 4
seconds. If the hard drive LED does not turn on
white then:
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1.

Check that the unit is plugged into a
working AC outlet.

2.

Open rear cover and check that the power
button cable is properly connected to the
system board.

3.

Check to see if the 5V_aux light on the
system board is turned on. If it is turned on,
then replace the power button board and
cable. If the problem persists, replace the
system board.

4.

Replace the AC adapter.

11 Password Security and Resetting
CMOS

This computer supports security password features, which can be established through the Computer
Setup Utilities menu.
This computer supports two security password features that are established through the Computer Setup
Utilities menu: setup password and power-on password. When you establish only a setup password,
any user can access all the information on the computer except Computer Setup. When you establish
only a power-on password, the power-on password is required to access Computer Setup and any
other information on the computer. When you establish both passwords, only the setup password will
give you access to Computer Setup.
When both passwords are set, the setup password can also be used in place of the power-on
password as an override to log in to the computer. This is a useful feature for a network administrator.
If you forget the password for the computer, you can clear that password so you can gain access to the
information on the computer by resetting the password jumper.
CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important to
back up the computer CMOS settings before resetting them in case they are needed later. Back up is
easily done through Computer Setup. See Computer Setup (F10) Utility on page 64 for information.
CAUTION: If you enable the stringent security feature in Computer Setup and you forget the setup
password or the power-on password, the computer is inaccessible and can no longer be used.
Enabling the stringent password disables the ability to reset the password by moving the jumper on the
system board.
If you lose or forget the password, the system board must be replaced. This scenario is not covered
under warranty.
To prevent the computer from becoming permanently unusable, record your configured setup password
or power-on password in a safe place away from your computer. Without these passwords, the
computer cannot be unlocked.
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Establishing a Setup or Power-on password
To establish the power-on or setup password features, complete the following steps:
1.

Turn on or restart the computer.

2.

As soon as the computer turns on, press the Esc key while “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

3.

Press the F10 key to enter Computer Setup.

4.

To establish Setup password, select Security > Setup Password and follow the instructions.
– or –
To establish a Power-On password, select Security > Power-On Password and follow the
instructions on the screen

5.
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Before exiting, click File > Save Changes and Exit.
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Resetting the Setup and Power-on password
To disable the power-on or setup password features, or to clear the power-on or setup passwords,
complete the following steps:
1.

Shut down the operating system properly, then turn off the computer and any external devices,
and disconnect the power cord from the power outlet.

2.

With the power cord disconnected, press the power button again to drain the system of any
residual power.
WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system components
to cool before touching.
CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can result
in damage to the system.
Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Regulatory, Safety and Environmental Notices guide
for more information.

3.

Remove the rear cover.

4.

Locate the header and jumper labeled PSWD.
NOTE: The password jumper is blue so that it can be easily identified. For assistance locating
the password jumper and other system board components, see the Illustrated Parts & Service Map
(IPSM). The IPSM can be downloaded from http://www.hp.com/support.

5.

Remove the jumper.

6.

Replace the jumper.

7.

Replace the rear cover.

8.

Reconnect the external equipment.

9.

Plug in the computer and turn on power. Allow the operating system to start. This clears the current
passwords and disables the password features.

10. Establish the new passwords in Computer Setup. See Computer Setup (F10) Utility on page 64 for
information.

Resetting the Setup and Power-on password
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Clearing and resetting the CMOS
The computer’s configuration memory (CMOS) stores information about the computer’s configuration.
The CMOS button resets CMOS but does not clear the power-on and setup passwords.
Clearing CMOS will clear the Active Management Technology (AMT) settings in the Management
Engine BIOS Extension (MEBx), including the password. The password will default to “admin” and will
need to be reset. The AMT settings will also need to be reset. To access the MEBx, press Ctrl+P during
POST.
1.

Turn off the computer and any external devices, and disconnect the power cord from the power
outlet.

2.

Disconnect the keyboard, monitor, and any other external equipment connected to the computer.
WARNING! To reduce the risk of personal injury from electrical shock and/or hot surfaces, be
sure to disconnect the power cord from the wall outlet, and allow the internal system components
to cool before touching.
CAUTION: When the computer is plugged in, the power supply always has voltage applied to
the system board even when the unit is turned off. Failure to disconnect the power cord can result
in damage to the system.
Static electricity can damage the electronic components of the computer or optional equipment.
Before beginning these procedures, ensure that you are discharged of static electricity by briefly
touching a grounded metal object. See the Safety & Regulatory Information guide for more
information.

3.

Remove the computer cover or rear cover.
CAUTION: Pushing the CMOS button will reset CMOS values to factory defaults. It is important
to back up the computer CMOS settings before resetting them in case they are needed later. Back
up is easily done through Computer Setup. See Computer Setup (F10) Utility on page 64 for
information on backing up the CMOS settings.
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4.

Locate, press, and hold the CMOS button in for five seconds.
NOTE: Make sure you have disconnected the AC power cord from the wall outlet. The CMOS
button will not clear CMOS if the power cord is connected.
Figure 11-1 CMOS button

NOTE: For assistance locating the CMOS button and other system board components, see the
Illustrated Parts & Service Map (IPSM).
5.

Replace the computer cover or rear cover.

6.

Reconnect the external devices.

7.

Plug in the computer and turn on power.
NOTE: You will receive POST error messages after clearing CMOS and rebooting advising you
that configuration changes have occurred. Use Computer Setup to reset any special system setups
along with the date and time.

For instructions on Computer Setup, see Computer Setup (F10) Utility on page 64.

Clearing and resetting the CMOS
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Power Cord Set Requirements

The power supplies on some computers have external power switches. The voltage select switch feature
on the computer permits it to operate from any line voltage between 100-120 or 220-240 volts AC.
Power supplies on those computers that do not have external power switches are equipped with
internal switches that sense the incoming voltage and automatically switch to the proper voltage.
The power cord set received with the computer meets the requirements for use in the country where you
purchased the equipment.
Power cord sets for use in other countries must meet the requirements of the country where you use the
computer.

General requirements
The requirements listed below are applicable to all countries:
1.

The power cord must be approved by an acceptable accredited agency responsible for evaluation
in the country where the power cord set will be installed.

2.

The power cord set must have a minimum current capacity of 10A (7A Japan only) and a nominal
voltage rating of 125 or 250 volts AC, as required by each country’s power system.

3.

The diameter of the wire must be a minimum of 0.75 mm2 or 18AWG, and the length of the cord
must be between 1.8 m (6 feet) and 3.6 m (12 feet).

The power cord should be routed so that it is not likely to be walked on or pinched by items placed
upon it or against it. Particular attention should be paid to the plug, electrical outlet, and the point
where the cord exits from the product.
WARNING! Do not operate this product with a damaged power cord set. If the power cord set is
damaged in any manner, replace it immediately.

Japanese Power Cord Requirements
For use in Japan, use only the power cord received with this product.
CAUTION: Do not use the power cord received with this product on any other products.

148

Appendix A Power Cord Set Requirements

Country-specific requirements
Additional requirements specific to a country are shown in parentheses and explained below.
Country

Accrediting Agency

Country

Accrediting Agency

Australia (1)

EANSW

Italy (1)

IMQ

Austria (1)

OVE

Japan (3)

METI

Belgium (1)

CEBC

Norway (1)

NEMKO

Canada (2)

CSA

Sweden (1)

SEMKO

Denmark (1)

DEMKO

Switzerland (1)

SEV

Finland (1)

SETI

United Kingdom (1)

BSI

France (1)

UTE

United States (2)

UL

Germany (1)

VDE

1.

The flexible cord must be Type HO5VV-F, 3-conductor, 0.75mm2 conductor size. Power cord set fittings (appliance
coupler and wall plug) must bear the certification mark of the agency responsible for evaluation in the country where it
will be used.

2.

The flexible cord must be Type SVT or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15A, 125V) or NEMA 6-15P (15A, 250V) configuration.

3.

Appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. Flexible cord must be Type VCT or VCTF, 3-conductor, 0.75 mm2 conductor size. Wall plug must
be a two-pole grounding type with a Japanese Industrial Standard C8303 (7A, 125V) configuration.

Country-specific requirements
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Statement of Volatility–HP EliteDesk
800 G1

HP confirms that the Intel-based business desktop HP EliteDesk 800 G1 Desktop Mini system contains
DDR3 volatile memory (memory amount depends on the customer configuration). In addition, the
motherboard in the condition originally shipped without subsequent modification or the addition or
installation of any applications, features, or functionality, contain the following nonvolatile memory:
Real Time Clock battery backed-up configuration memory (256 Bytes), DIMM Serial Presence Detect
(SPD) configuration data (256 Bytes per module, 128 Bytes programmable), Serial Peripheral Interface
(SPI) ROM for System BIOS (16M Bytes) and Super I/O’s: masked keyboard ROM (overall 2K Bytes).
In addition, these units contain a Trusted Platform Module (TPM) that contains 16K Bytes of non-volatile
memory for user data. The volatile memory will not hold any user data once power has been removed
for 30 seconds or longer.
Please find below a list of steps that should be taken to restore the Non Volatile memory found in the
Intel-based HP EliteDesk 800 G1 systems.
1.

Download the latest BIOS for this system and operating system off of the HP website.

2.

Follow the instructions on the website to flash the BIOS.

3.

Shut down Windows, and then turn on the computer and enter the Computer Setup Utility by
pressing the esc key when the “Press the ESC key for Startup Menu” prompt appears near the
bottom of the screen (before the operating system loads). Choose Computer Setup (F10) from
the list of options.

4.

From the main menu, select Security – System Security. In the menu, if the Embedded Security
Device Support option shows “Disable”, skip to step 7.

5.

To erase all security keys from the TPM: under Embedded Security Device in the System
Security menu, configure Reset to Factory Settings to Reset.
NOTE: Although the TPM security keys will be cleared, data in the non-volatile memory indices
may not be. Data stored in these indices should not contain security sensitive information. If an
application locks down and secures the non-volatile indices, these indices cannot be cleared.
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6.

Press F10 to accept changes.

7.

To clear the secure boot key database, enter the F10 Setup Utility, and then go to the Security
menu.

8.

Select Secure Boot Configuration.

Appendix B Statement of Volatility–HP EliteDesk 800 G1

9.

Move the arrow to pick Clear Secure boot keys in the Key Management section.

10. Use the spacebar key to choose clear.
11. Press F10 to accept changes.
12. From the main menu, select File > Save Changes and Exit.
13. Enter the F10 Setup Utility.
14. If the Ownership Tag or Asset Tag is set, manually clear it under Security > System IDs.
15. From the main menu, select File > Save Changes and Exit.
16. To clear the Setup and/or Power-On passwords if set, enter the F10 Setup Utility, and then go to
the Security menu.
17. Select Password Options if available.
18. Disable the Stringent Password setting if present and enabled.
19. Press F10 to accept the changes, and select Save Changes and Exit.
20. Shut down the computer, remove the power cord, and then remove the access panel.
21. Locate the green two pin password jumper on header E49 (labeled PSWD) and remove it.
22. Remove the AC power, wait 10 seconds until the unit AC power drains out, then press the CMOS
button. This is typically a yellow push button (labeled CMOS).
23. Replace the access panel and AC power cord, and then turn the computer on. The passwords are
now cleared and all other user-configurable, non-volatile memory settings are reset to their factory
default values.
24. Enter the F10 Setup Utility.
25. Select File > Default Setup > Restore Factory Settings as Default. This action resets
settings back to their factory defaults.
26. Select File > Apply Defaults and Exit.
27. Shut down the computer, remove the AC power cord, and then place the green jumper back on
header E49.
28. Replace the access panel and power cord.
If Absolute Persistence is enabled on the computer, see the service provider for instruction to disable the
feature.
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Statement of Volatility–HP ProDesk
600 G1

HP confirms that the Intel-based business desktop HP ProDesk 600 G1 Desktop Mini system contains
DDR3 volatile memory (memory amount depends on the customer configuration). In addition, the
motherboard in the condition originally shipped without subsequent modification or the addition or
installation of any applications, features, or functionality, contain the following nonvolatile memory:
Real Time Clock battery backed-up configuration memory (256 Bytes), DIMM Serial Presence Detect
(SPD) configuration data (256 Bytes per module, 128 Bytes programmable), Serial Peripheral Interface
(SPI) ROM for System BIOS (16M Bytes) and Super I/O’s: masked keyboard ROM (overall 2K Bytes).
In addition, these units contain a Trusted Platform Module (TPM) that contains 16K Bytes of non-volatile
memory for user data. The volatile memory will not hold any user data once power has been removed
for 30 seconds or longer.
Please find below a list of steps that should be taken to restore the Non Volatile memory found in the
Intel-based HP ProDesk 600 G1 systems.
1.

Download the latest BIOS for this system and operating system off of the HP website.

2.

Follow the instructions on the website to flash the BIOS.

3.

Shut down Windows, and then turn on the computer and enter the Computer Setup Utility by
pressing the esc key when the “Press the ESC key for Startup Menu” prompt appears near the
bottom of the screen (before the operating system loads). Choose Computer Setup (F10) from
the list of options.

4.

From the main menu, select Security – System Security. In the menu, if the Embedded Security
Device Support option shows “Disable”, skip to step 7.

5.

To erase all security keys from the TPM: under Embedded Security Device in the System
Security menu, configure Reset to Factory Settings to Reset.
NOTE: Although the TPM security keys will be cleared, data in the non-volatile memory indices
may not be. Data stored in these indices should not contain security sensitive information. If an
application locks down and secures the non-volatile indices, these indices cannot be cleared.
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6.

Press F10 to accept changes.

7.

To clear the secure boot key database, enter the F10 Setup Utility, and then go to the Security
menu.

8.

Select Secure Boot Configuration.

Appendix C Statement of Volatility–HP ProDesk 600 G1

9.

Move the arrow to pick Clear Secure boot keys in the Key Management section.

10. Use the spacebar key to choose clear.
11. Press F10 to accept changes.
12. From the main menu, select File > Save Changes and Exit.
13. Enter the F10 Setup Utility.
14. If the Ownership Tag or Asset Tag is set, manually clear it under Security > System IDs.
15. From the main menu, select File > Save Changes and Exit.
16. To clear the Setup and/or Power-On passwords if set, enter the F10 Setup Utility, and then go to
the Security menu.
17. Select Password Options if available.
18. Disable the Stringent Password setting if present and enabled.
19. Press F10 to accept the changes, and select Save Changes and Exit.
20. Shut down the computer, remove the power cord, and then remove the access panel.
21. Locate the green two pin password jumper on header E49 (labeled PSWD) and remove it.
22. Remove the AC power, wait 10 seconds until the unit AC power drains out, then press the CMOS
button. This is typically a yellow push button (labeled CMOS).
23. Replace the access panel and AC power cord, and then turn the computer on. The passwords are
now cleared and all other user-configurable, non-volatile memory settings are reset to their factory
default values.
24. Enter the F10 Setup Utility.
25. Select File > Default Setup > Restore Factory Settings as Default. This action resets
settings back to their factory defaults.
26. Select File > Apply Defaults and Exit.
27. Shut down the computer, remove the AC power cord, and then place the green jumper back on
header E49.
28. Replace the access panel and power cord.
If Absolute Persistence is enabled on the computer, see the service provider for instruction to disable the
feature.
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Specifications

Dimensions (with stand)
Height

13.5 in

34.3 cm

Width

19.5 in

49.5 cm

Depth

3.0 in

7.7 cm

Height

13.4 in

33.9 cm

Width

19.5 in

49.5 cm

Depth

2.0 in

5.2 cm

(With stand)

12.2 lb – 12.9 lbs

5.55 kg – 5.84 kg

(Without stand)

11.2 lb – 11.8 lbs

5.07 kg – 5.36 kg

50° to 95°F

10° to 35°C

-22° to 140°F

-30° to 60°C

10-90%

10-90%

5-95%

5-95%

Dimensions (without stand)

Approximate Weight

Temperature Range
Operating
(At sea level with an altitude derating of 1.0°C per every 1000 ft
(304.8m) above sea level to a maximum of 10,000 ft (3048m), no
direct sustained sunlight. Maximum rate of change is 10°C/Hr. The
upper limit may be limited by the type and number of options
installed.)
Storage
(Maximum rate of change: 20°C/Hr.)
Relative Humidity (non-condensing)
Operating
(Relative humidity (Rh), 28°C maximum wet bulb temperature, noncondensing.)
Storage
(Relative humidity (Rh), 38.7°C maximum wet bulb temperature,
non-condensing.)
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Maximum Altitude (unpressurized)
Operating

0 - 10,000 ft

0 - 3,048 m

0 - 30,000 ft

0 - 9,144 m

(This value may be limited by the type and number of options
installed. Maximum allowable altitude change rate is 1500 ft/min
(457m/min)).
Non-operating
(Maximum allowable altitude change rate is 1500 ft/min (457m/
min).)
Power Supply
Rated Voltage Range

100-240 V

Rated Line Frequency

50-60 Hz

Max Operating Power

65 W
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access panel
removal 26
spare part number 18, 24
adapter, DisplayPort HDMI VGA,
spare part number 21
adapter, DisplayPort to DVI, spare
part number 21
adapter, DisplayPort to VGA, spare
part number 21
antenna cover, spare part
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spare part number 60
audible codes 140
audio problems 99
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safety precautions 13
CMOS
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clearing and resetting 146
computer cleaning 13
country power cord set
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D
DisplayPort cable, spare part
number 21
drive cage
removing 47

B
Backup and Restore 127
battery
disposal 16
battery replacement 40
booting options
Full Boot 131

E
electrostatic discharge (ESD) 9
preventing damage 10
error
codes 131, 140
messages 132
external connection antennas
removing 53

C
cable lock, spare part number 22
cable management 17
cable pinouts, SATA data 17
cautions
AC power 9
cables 15
electrostatic discharge 9
keyboard cleaning 14
keyboard keys 14
CD-ROM or DVD problems 114
chasis types, illustrated 9
cleaning
computer 13

F
f11 recovery 129
fan
removing 46
spare part number 24, 46
fan, spare part number 20
flash drive problems 116
flashing LEDs 140
front bezel
removing 34
spare part number 18, 23,
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front panel components 2
front panel problems 117

156

Index

G
general problems 83
grommet, spare part number 20
grounding methods 11
H
hard drive
installation 28
proper handling 15
removal 28
SATA characteristics 16
hard drive problems 89
hard drive recovery 129
hardware installation problems
105
heat sink
removing 43
spare part number 24, 43
heat sink, spare part number 20
helpful hints 81
hood sensor assembly, spare part
number 20, 24
I
installing
battery 40
hard drive 28
memory 35
Internet access problems 118
K
keyboard
cleaning 13
keyboard problems 103
keyboards
spare part number 19

L
LED cover, spare part number 20,
24
LEDs
blinking power 140
blinking PS/2 keyboard 140
M
M.2 SSD
removing 51
Media Card Reader problems 92
memory
installation 35
socket population 36
specifications 35
memory modules
spare part number 19
memory problems 111
monitor problems 94
mouse
cleaning 14
spare part number 21
mouse problems 103
N
network problems 107
numeric error codes 132
O
opening the computer 25
operating guidelines 12
optical drive problems 114
overheating, prevention 12
P
password
clearing 143
power-on 143
setup 143
POST error messages 131
power cord set requirements
country specific 149
power problems 87
power supply 155
spare part number 19
power-on password 143
printer problems 101
problems
audio 99
CD-ROM or DVD 114
flash drive 116

front panel 117
general 83
hard drive 89
hardware installation 105
Internet access 118
keyboard 103
Media Card Reader 92
memory 111
monitor 94
mouse 103
network 107
power 87
printer 101
processor 113
software 119
processor
spare part number 19
processor problems 113
product ID location 5
R
rear cover, locked 84
rear panel components
EliteDesk 800 3
ProDesk 600 4
recovery partition 129
removal and replacement
procedures
chassis
25
drive cage 47
external connection antennas
53
fan 46
front bezel 34
heat sink 43
M.2 SSD 51
preparing to disassemble the
computer 25
speaker 32
system board 57
thermal module 43
WLAN antennas 60
WLAN module 49
removing
battery 40
computer access panel 26
hard drive 28
resetting
CMOS 143
password jumper 143

restoring the hard drive 129
S
safety and comfort 80
safety precautions
cleaning 13
SATA
connectors on system board
16
data cable pinouts 17
hard drive characteristics 16
SATA power cable, spare part
number 21, 24
screws, correct size 15
serial number location 5
service considerations 14
setup password 143
software
problems 119
servicing computer 14
spare part number
tamper-resistant wrench 15
Torx T-15 screwdriver 14
speaker
removing 32
spare part number 23, 32
speaker, spare part number 20
specifications
computer 154
memory 35
stand
spare part number 19, 24
Statement of Volatility (SOV) 150,
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static electricity 10
system board
removing 57
SATA connectors 16
spare part number 19, 57
system board,
spare part number 23
T
tamper-proof screws
tool 15
temperature control 12
thermal module
removing 43
tools, servicing 14
Torx T15 screwdriver 14
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tower conversion 27
U
USB to serial converter, spare part
number 21
V
ventilation, proper 12
W
Wake-on-LAN feature 107
Windows 8 operating system
DVD 129
wireless antenna cable, spare part
number 21, 24
WLAN antennas
removing 60
WLAN module
removing 49
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